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1.  MINIMALNE WYMAGANIA
Dla poprawnego funkcjonowania  programu progeCAD decydującymi  są prędkość  procesora,

prędkość karty graficznej,  wielkość pamięci  RAM oraz pojemność dysku twardego.  Minimalne

wymagania sprzętowe i programowe to:

System operacyjny: Windows  8  lub  8.1  (32-bit  lub  64-bit),  Windows  7  (32-bit  lub  64-bit),

Windows Vista (32-bit lub 64-bit), Windows XP.

Procesor: Intel Pentium® IV (lub szybszy).

Pamięć operacyjna: 1 GB RAM, zalecane 2 GB RAM i więcej.

Karta graficzna: pamięć 512 MB DDR3 z obsługą OpenGL, 

zalecana NIEZINTEGROWANA karta graficzna z 1 GB DDR3 oraz obsługą 

OpenGL lub DDR5 z  obsługą OpenGL.

Dysk twardy: 4 GB miejsca na twardym dysku.

Wydajność jest także zależna od prędkości procesora, mocy przeliczeniowej karty graficznej,

użytkowanych  sterowników  (wydajność  najbardziej  obniżają  nieaktualne  sterowniki  karty

graficznej), prędkości dysku twardego (dysk SSD ma o wiele większą prędkość odczytu niż dysk

klasyczny) itd..
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2.  INSTALACJA PROGRAMU
Plik  instalacyjny  ostatniej  wersji  progeCAD  2014  można  znaleźć  zawsze  na  stronie

www.progecad.pl

www.progecad.pl → Download → progeCAD Professional → programy

Bezpośredni odnośnik do działu Download.

2.1.  Windows XP

1. Upewnij się, iż jesteś zalogowany z prawami administratora.

2. Uruchom plik instalacyjny.

3. Przeprowadź instalację według wskazówek instalatora.

4. Poczekaj na dokończenie instalacji.

2.2.  Windows Vista

1. Upewnij się, iż jesteś zalogowany z prawami administratora.

2. Z menu Start wybierz Panel sterowania.

3. Otwórz Konta użytkowników.

4. W panelu wybierz Zmień ustawienia funkcji Kontrola konta użytkownika.

5. Jeśli funkcja Kontrola konta użytkownika jest włączona, wypnij ją i potwierdzić OK.

6. Zrestartuj komputer, jeśli jest to wymagane.

7. Uruchom plik instalacyjny.

8. Przeprowadź instalację według wskazówek instalatora.

9. Poczekaj do końca instalacji.

10. Kliknij prawym klawiszem myszy na skrót progeCAD Professional i wybierz Uruchom jako

administrator.

11. Według punktów 2-4 możesz z  powrotem włączyć funkcję  Kontrola konta użytkownika,

a jeśli to konieczne, zrestartuj komputer.

2.3.  Windows 7

1. Upewnij się, iż jesteś zalogowany z prawami administratora.

2. Z menu Start wybierz Panel sterowania.

3. Otwórz Konta użytkowników.

4. W panelu wybierz Zmień ustawienia funkcji Kontrola konta użytkownika.

5. Jeśli ustawienia powiadomień o zmianach są w komputerze dozwolone, przeciągnij suwak

aż  na  sam  dół  i  potwierdź  poprzez  OK a  następnie  Tak.  Jeśli  będzie  to  konieczne,

to zrestartuj komputer.
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6. Uruchom plik instalacyjny.

7. Przeprowadź instalację według wskazówek instalatora.

8. Poczekaj do końca instalacji.

9. Kliknij prawym klawiszem myszy na skrót progeCAD Professional i wybierz Uruchom jako

administrator.

10. Możesz zmienić nastawienia funkcji  Ustawienia kontroli konta użytkownika  na pierwotny

poziom.

2.4.  Windows 8 a 8.1

1. Upewnij się, iż jesteś zalogowany z prawami administratora.

2. W środowisku Modern UI znajdź i uruchom Panel sterowania.

3. Otwórz Konta użytkowników.

4. W panelu wybierz Zmień ustawienia funkcji Kontrola konta użytkownika.

5. Jeśli ustawienia powiadomień o zmianach są w komputerze dozwolone, przeciągnij suwak

aż  na  sam  dół  i  potwierdź  poprzez  OK a  następnie  Tak.  Jeśli  będzie  to  konieczne,

to zrestartuj komputer.

6. Kliknij  na  plik  instalacyjny  prawym klawiszem i  wybierz  Uruchom jako  administrator

i uruchom instalację.  Przy uruchamianiu instalacji  może być  koniecznym zezwolenie  jej

na to (czasami poprzez szczegółowe ostrzeżenia) i wyłączenie programu antywirusowego.

7. Przeprowadź instalację według wskazówek instalatora.

8. Poczekaj do końca instalacji.

9. Kliknij prawym klawiszem myszy na skrót progeCAD Professional i wybierz Uruchom jako

administrator.

10. Możesz zmienić nastawienia funkcji  Ustawienia kontroli konta użytkownika  na pierwotny

poziom.

W przypadku konieczności skontaktuj się z pomocą techniczną.
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Informacja:

Jeśli  pobierzesz  plik  instalacyjny

ze strony  www.progecad.pl,

to po uruchomieniu  rozpakuje  się

on i zapisze  na  twardym  dysku

do folderu  C:\SoliCAD\progeCAD...

a na pulpicie  zostanie  utworzony  skrót

do uruchomienia menu instalacji.

W menu tym znajduje się możliwość

instalacji  wersji  próbnej,  pełnej  (single,

USB,  NLM)  i  edukacyjnej  progeCAD

Professional,  polski  podręcznik,

dodatkowe  linie  i  style  kreskowania,

sterowniki  do  klucza  USB  oraz  plik

instalacyjny serwera NLM.

Po zainstalowaniu progeCAD Professional można usunąć folder SoliCAD, ale tym samym utraci

się szybki dostęp do instrukcji, podręcznika itp.
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3.  USTAWIENIA I ICH ODNAWIANIE

3.1.  Zalecane ustawienia

Nowym użytkownikom zalecamy przeprowadzenie kilku drobnych zmian, które ułatwią pracę

z progeCAD Professional.

1. Przesuń paski  narzędzi  Zmiana i Kolejność  rysowania  na lewą stronę okna obok paska

Rysuj.  Przesunięcie  przeprowadź  za  pomocą  złapania  paska  lewym  klawiszem  myszy

za szerszą krawędź.

Paski narzędzi Zmiana i Kolejność rysowania

2. Rozciągnięcie  okna  poleceń  na  szerokość  3-4  wierszy.  Wiersz  poleceń  będzie  bardziej

przejrzysty, zobaczysz historię ostatnich poleceń itd.

3. W górnym pasku menu Narzędzia → Opcje w zakładce Ogólne nastaw:

• automatyczne zapisywanie na pożądany czas (domyślnie 15 minut),

• opcję Zapisz jako: na pożądaną domyślną wersję wykresu.

4. W zakładce Uchwyty zmień żółty kolor symbolu uchwytu na jasnozielony (numer 3).

5. Następnie  w  zakładce  Wyświetl oznacz  Wyświetl  ofertę  poleceń oraz  możesz  dokonać

zmiany  ustawień  Koloru  graficznego  ekranu (tło  przestrzeni  roboczej)  i  Koloru

arkusza/układu (przestrzeń wydruku).

6. Potwierdź poprzez kliknięcie w przycisk OK. 

Informacja:

Opcje  ustawień  programu  zawierają  dość  szerokie  nastawienia  progeCAD  jak  np.  sposób

otwierania  wykresów,  zabezpieczenia  VBA,  rozszerzenia  przy  automatycznym  zapisywaniu,

ustawienia  ścieżek  do  szablonów,  słowników  itd.,  ustawienia  wyświetlania  (wydajność

i rozdzielczość wyświetlania,  kolory ekranu,  schematy kolorów, liczba  wierszy w oknie historii

paska  poleceń),  sposób  wyboru  obiektów,  koloru  prostokąta  wyboru,  wyświetlania  węzłów,

ustawienia krzyży nitkowych, przełączanie profilu środowiska pracy, ustawienia druku, zachowania

uchwytów lub  nastawienia  schowka  wklejanych  wykresów.  Niektóre  dalsze  ustawienia  zostaną

także omówione w tym podręczniku.
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3.2.  Prawe kliknięcie myszy, menu kontekstowe, kliknięcie definiowane
czasowo

Menu kontekstowe uzyskasz klikając prawym klawiszem myszy w obiekt (element) na wykresie,

pasek  narzędzi,  pasek  stanu  czy  inne  elementy.  Umożliwia  ono  szybki  dostęp  do  poleceń,

przypisanych  danemu  rodzajowi  obiektów  a  jego  treść  zmienia  się  według  tego,  gdzie  było

wyświetlone.

Przy  kliknięciu  prawym  klawiszem  na  pasek  narzędzi  lub  pasek  stanu  możesz  w  menu

kontekstowym ustawić widoczność pozostałych pasków. Jeśli na wykresie wybierzesz jeden lub

więcej obiektów, prawe kliknięcie przedstawi opcje ich modyfikacji.

Użycie Shift + prawe kliknięcie gdziekolwiek na wykresie w czasie rysowania wyświetli opcje

tymczasowych ustawień uchwytu obiektu.

Prawe  kliknięcie  w  progeCAD można  wykorzystać  na  wiele  sposobów.  W  domyślnych

ustawieniach po takim kliknięciu pojawi się menu kontekstowe, gdzie możesz wybrać poszczególne

narzędzia/działania, a przy trwającym poleceniu funkcjonuje jako klawisz Enter. 

Każdy  użytkownik  może  preferować  inne  ustawienia,  na  przykład  powtarzanie  ostatnio

wykonanego  polecenia.  Nową  funkcją  w  wersji  2014  czasowo  definiowane  kliknięcie,  gdzie

w zależności od długości kliknięcia dochodzi do powtórzenia ostatniego polecenia lub wyświetlenia

pola menu kontekstowego.

Zmiana ustawień:

Narzędzia → Opcje → zakładka Ogólne → Dostosowanie prawego kliknięcia myszki...
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3.3.  Odnowienie kopii automatycznej

Kopia  automatyczna  (wg  ustawień  domyślnych)  zapisuje

się  do  folderu  Temp (więcej  o  ustawieniach  w  akapicie

 3.1 Zalecane ustawienia) i ma rozszerzenie *.SV$. Po zmianie

rozszerzenia na  *.dwg można wykres otworzyć w progeCAD

podobnie do jakiegokolwiek innego rysunku.

Jednocześnie progeCAD po błędzie aplikacji i ponownym

włączeniu  programu  zaoferuje  automatyczne  odnowienie

wszystkich  dostępnych  wykresów  w oknie  Odnowienie

rysunku.  Przy  kliknięciu  w  rysunek  w  dolnej  części  okna

wyświetli  się  nazwa wykresu,  lokalizacja  pliku,  data  i  czas

jego ostatniego zapisu oraz wielkość.

Aby odnowić rysunek wystarczy na niego kliknąć  w oknie  odnowienie  rysunku a  następnie

za pomocą opcji Plik→ Zapisz jako wykres zapisać (najlepiej pod inną nazwą).

3.4.  Centrum progeCAD

We  wcześniejszych  wersjach  programu  wszystkie  narzędzia  i  aplikacje  znajdowały  się

w folderze progeCAD Professional  w menu Start.  Ze wprowadzeniem Windows 8 ujednolicono

wygląd  wszystkich  narzędzi  i  aplikacji  i  zebrano  je  w jednym graficznym układzie  w ramach

Centrum progeCAD.

Centrum  progeCAD  można  uruchomić

w zakładce  Pomoc  albo poprzez  skrót  w  menu

Start  (starsze  Windowsy  bądź  Windows  8

z doinstalowanym  menu  Start)  lub  za  pomocą

ikony  w  środowisku  Modern  UI  (Metro)

w Windows 8.

Alternatywnie  Centrum  progeCAD  możesz

uruchomić  za  pomocą  pliku  center.exe

znajdującego  się  w  folderze  center w  pliku

instalacyjnym progeCAD.

Np.  C:\Program  Files

(x86)\progeCAD\progeCAD  2014  Professional

PLK\center.
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W  górnej  części  [1]  można  włączać  określone  funkcje  lub  przełączać  między  głównymi

pozycjami. W dolnej części [2] wyświetlają się szczegółowe zagadnienia dla konkretnych pozycji.

W skład Centrum progeCAD wchodzą:

1. Uruchom progeCAD Professional [1] – uruchamia progeCAD.

2. Zarejestruj  progeCAD Professional  [1] –  zainicjowanie procesu rejestracji  progeCAD.

Opcję można wykorzystać także do przerejestrowania lub zmiany kodu licencji (najczęściej

w przypadku licencji sieciowych).

3. Pomoc on-line [1] - połączenie z pomocą techniczną

4. Pomoc / Video [1]

a) Pomoc dla progeCAD 2014 Professional [2] - otwiera plik pomocy programu w wersji

angielskiej.

b) Pomoc  dla  programistów [2] -  angielka  dokumentacja  dla  developerów

oprogramowania  w  środowiskach  LISP,  DCL,  SDS,  Visual  Basic  for  Applications

(VBA).

c) Filmy instruktażowe [2] - odnośnik do filmów szkoleniowych.

5. Ustawienia [1]

a) Akceleracja  sprzętowa  [2] -  zwiększa  wydajność  programu.  Jeśli  masz  problemy

ze sprawnym działaniem progeCAD, to deaktywuj tę funkcję. 

b) Napraw [2] – naprawa błędów w celu poprawy brakujących lub uszkodzonych plików,

skrótów, zapisów rejestru, pasków narzędzi i menu.

c) Automatyczne  aktualizacje  [2] –  dokumentacja  dla  developerów  oprogramowania

w środowiskach LISP, DCL, SDS, Visual Basic for Applications (VBA).

d) Folder  ustawień  użytkownika -  dostęp  do  folderu  zawierającego  linie,  style

kreskowania, szablony, ustawienia użytkownika itd.

6. Narzędzia [1]

a) LispDefender [2] – narzędzie do szyfrowania LISP. Zabezpiecza przed niechcianym

kopiowaniem kodu źródłowego przez inną osobę.

b) NLM TakeAway [2] – narzędzie do administracji (wypożyczania, zwracania) sieciową

licencją na serwerze NLM w użytku pozasieciowym.

c) Ustawienia  NLM  [2] –  umożliwia  nastawienie  nowego  adresu  IP  i  portu  w  celu

konfiguracji progeCAD Professional NLM.

d) Odinstaluj progeCAD [2] – odinstalowanie progeCAD Professional ze wszystkimi jego

elementami.

7. Narzędzia pomocy [1]

a) Zdalna pomoc techniczna [2] – przejście do zdalnej pomocy technicznej. Umożliwia

ona  kontrolę  Twojego  komputera  na  odległość.  Wykorzystanie  tej  funkcji  jest

uzależnione od prośby pomocy technicznej.

b) Konsultant techniczny [2] – narzędzie przeznaczone do pomocy technicznej.

c) Dumper [2] – narzędzie przeznaczone do pomocy technicznej.
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d) Dodatki progeCAD [2] - dostęp do strony internetowej z dodatkowymi komponentami

do pobrania dla różnych wersji progeCAD.

3.5.  Odnowienie domyślnych ustawień programu

Niniejsze  działania  doprowadzą  do  całkowitego  odnowienia  ustawień  progeCAD.  Wykonaj

odnowienie  ustawień,  kiedy  zauważysz,  że  progeCAD  zachowuje  się  niestandardowo,  nie  jest

możliwe  jego  uruchomienie,  blokuje  się  przy  włączaniu  itp.  Więcej  szczegółów  o  możliwych

problemach z uruchomianiem progeCAD, wyświetlanymi błędami itd. znajdziesz w P  rzewodniku

po usuwaniu problemów.

Są dwa sposoby odnowienia ustawień – z pozostawieniem folderu ustawień użytkownika albo

pełne odnowienie z jego usunięciem.

Przy  pozostawieniu  folderu  ustawień  użytkownika możesz  wybrać  konkretne  pozycje

do odnowienia.

Pełne  odnowienie  wymaże  wszelkie  zapisy  z  rejestru  (tj.  ustawienia  zmiennych,  skróty

klawiszowe, aliasy, położenie paneli/pasków narzędzi, górnego menu, układu okien) i usunie folder

ustawień użytkownika (szablony, style kreskowania, linie, ustawienia druku). 

Folder ustawień użytkownika znajduje się w poniższej lokalizacji:

Windows XP:

C:\Documents and Settings\nazwa_użytkownika\Data Applications\ProgeCAD\progeCAD\R14\Pro
fessional – Polish

Windows Vista, 7 i 8:

C:\Users\nazwa_użytkownika\AppData\Roaming\ProgeCAD\progeCAD\R14\Professional – Polish

Informacja:

Przed  dokonaniem  odnowienia  ustawień  możesz  zabezpieczyć  folder  ustawień  użytkownika

poprzez skopiowanie całego folderu, a także zapisać ustawienia skrótów klawiszowych, aliasów itp.

za pomocą eksportu ustawień. Eksport przeprowadza się bezpośrednio w progeCAD wybierając

w górnym menu  Narzędzia → Dostosuj → Menu...  Dla każdej zakładki musi się przeprowadzić

osobny eksport.
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 Procedura (pełnego) odnowienia ustawień:

1. Przed rozpoczęciem odnawiania  ukończ pracę  progeCAD.  Jeśli  progeCAD w dalszym

ciągu pracuje w tle, koniecznym będzie jego zamknięcie poprzez Managera zadań Windows

– proces icad.exe.

2. Odnowienie ustawień progeCAD można uruchomić za pomocą: 

• Centrum progeCAD → Ustawienia → Napraw

lub

• plikiem regcad.exe z folderu instalacyjnego progeCAD.

3. Kliknij TAK, oznacz Default (lub inny pożądany profil), kliknij OK.

4. Nastawienie odnowienia

a) Bez usuwania folderu ustawień użytkownika  – niczego nie zmieniaj  i  kliknij  OK,

(możesz też wybrać konkretne pozycje do odnowienia),

b) PEŁNE - Oznacz Usuń profil i Usuń lokalne ustawienia plików, kliknij OK a następnie

TAK.

5. Potwierdź poprzez OK.

Ostrzeżenie:

Jeśli nie przeprowadzisz pełnego odnowienia ustawień progeCAD, mogą w komputerze pozostać

ustawienia i pliki, które wywołują problemy. Podobna sytuacja może zatem nastać przy powrotnym

imporcie skrótów klawiszowych, aliasów, górnego menu i pasków narzędzi.

3.6.  Pełne odinstalowanie progeCAD Professional

Wykorzystaj tę procedurę, w przypadku gdy sposób przedstawiony w punkcie 3.5 Odnowienie

domyślnych ustawień programu nie usunął problemów. W ten sposób usuniesz i odnowisz wszelkie

ustawienia progeCAD - pozostaną wyłącznie informacje o rejestracji.

Procedura pełnego odinstalowania progeCAD

1. Najpierw  przeprowadź  odnowienie  ustawień  progeCAD  wg  punktu  3.5 Odnowienie

domyślnych ustawień programu. Po odnowieniu ustawień progeCAD nie możesz włączyć

z powrotem programu.

2. Odinstaluj  program  za  pomocą  funkcji  Dodaj/usuń  programy  w  Panelu  sterowania  lub

poprzez Narzędzie w Centrum progeCAD.

3. Usuń następujące foldery:

w Windows XP:

C:\Program Files\progeCAD

C:\Documents and Settings\NAZWA_UŻYTKOWNIKA\AppData\progeCAD

w Windows Vista, 7, 8:

C:\Users\NAZWA UŻYTKOWNIKA\AppData\Roaming\ProgeCAD\
C:\Program Files\progeCAD (system 32-bit)
C:\Program Files (x86)\progeCAD (system 64-bit)
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4. W menu Start wybierz Uruchom i wpisz REGEDIT potwierdzając klawiszem Enter.

5. Usuń z rejestru klucz – HKEY_CURRENT_USER\\Software\\progeCAD

UWAŻAJ,  BY NIE USUNĄĆ INNEGO KLUCZA! 

6. Zainstaluj  ostatnią  wersję  progeCAD.  Nie  będziesz  potrzebować  przeprowadzenia

powtórnej rejestracji. 

W przypadku potrzeby skontaktuj się z po  mocą techniczną.
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4.  INTERFEJS UŻYTKOWNIKA

A Górny panel menu.

B Standardowy pasek narzędzi i pasek warstw

C Przestrzeń robocza

D Krzyż układu współrzędnych – pokazuje orientację wykresu w przestrzeni 3D

E Zakładki modelu oraz układów do druku.

F
Pasek poleceń – umożliwia wprowadzenie pisemnych poleceń. W górnej części 

są odnotowywane informacje o wykonanych akcjach

G

Pasek stanu – przedstawia informacje, jakimi są działanie aktywowanego 

narzędzia, aktualne współrzędne kursora, ustawienia trybu rysowania (rysowanie 

prostopadłe, uchwyty obiektu, śledzenie skoku elementu, wyświetlanie siatki, 

ustawienia skoku, grubość linii), a także ikonę stanu progeCAD i  rysunku

H Paski narzędzi – pływające (przykład na obrazku) lub osadzone na skraju ekranu

I

Panel „Własności“ umożliwiający szczegółowe ustawienia. Aktywuje się go za 

pomocą CTRL + 1  (jeden) lub kliknięciem prawego klawisza myszy w obiekt lub 

w przestrzeń roboczą i wybór Własności

J

Zakładki otwartych rysunków - po kliknięciu prawym klawiszem myszy w 

zakładkę można wybrać zamknięcie rysunku, zamknięcie wszystkich rysunków, 

otwarcie folderu zawierającego itp.
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5.  PRACA Z PROGRAMEM

5.1.  Paski narzędzi

Paski  narzędzi  służą  ułatwieniu  i  przyspieszeniu  pracy  z  programem.  Zawierają  funkcje

posegregowane według kategorii.

Istnieją  2  rodzaje  pasków  narzędzi   -  osadzone

i pływające  (ryc.  5.4).  Paski  pływające  przenosi  się

za pomocą  kliknięcia  i  przeciągnięcia  lewej  krawędzi

(paski  poziome) lub  górnej  krawędzi  (paski  pionowe).

Poprzez  przeciągnięcie  osadzonego  paska  narzędzi

powstanie pasek pływający (ryc. 5.5).

W paskach znajdują się 2 rodzaje ikon - zwykłe oraz rozwijalne. Ikony

rozwijalne mają dodatkowo trójkąt  w prawym dolnym rogu (ryc.  5.1).

Aby wybrać funkcję z menu rozwijalnego należy kliknąć ikonę lewym

klawiszem  myszy  (nie  puszczając  przycisku)  i  przesunąć  kursor

na wybraną  funkcję  -  dopiero  wówczas  możesz  zwolnić  klawisz

(ryc. 5.2).

Większość rzadziej wykorzystywanych pasków jest z powodu lepszej

czytelności  programu  wyłączona.  Aby  je  włączyć/wyłączyć  należy

kliknąć  prawym  przyciskiem  myszy  w  którykolwiek  pasek  narzędzi.

Następnie rozwinie się oferta z nazwami wszystkich możliwych pasków

(ryc. 5.3),  gdzie kliknięcie  w jeden z nich wywoła jego włączenie lub

wyłączenie.  Podobne  działania  można  wykonać  w  zakładce  Widok  →

Paski narzędzi, gdzie grupowo można oznaczyć wybrane paski.

Rycina 5.1 Rycina 5.2

         Rycina 5.3      Rycina 5.4 Wygląd osadzonego paska narzędzi
           
 

      Rycina 5.5 Wygląd pływającego paska narzędzi
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Informacja:
Szczegółowe  ustawienia  pasków  narzędzi  i  skrótów  klawiszowych  znajdziesz  w  rozdziale

19.2 Ustawienia pasków narzędzi, dodanie ikon i skrótów klawiszowych.

5.2.  Osadzenie panelu Własności, managera warstw i paska poleceń

Jak  wskazano  wyżej,  progeCAD  umożliwia

dostosowanie  wyglądu  środowiska  pracy  poprzez

manipulację  panelami  narzędzi.  Dalej  możliwym  jest

osadzenie  panelu  Własności,  okna  managera  warstw

(więcej  o  działaniu  w  rozdziale  9.1 Menedżer

właściwości  warstwy)  oraz  paska  poleceń.  Managera

warstw włącza się za pomocą np. górnego menu Format

→ Warstwa... 

Osadzenie przeprowadzisz za pomocą przeciągnięcia

myszą do krawędzi programu, ewentualnie do krawędzi

przestrzeni  roboczej.  Przyszłe  osadzone  okna  oznaczą

się prostokątem.

W przypadku w ten sposób osadzonych paneli można

ustawić  ich  ukrywanie  (minimalizację).  Oznacza

to, że ukryte osadzone okno rozwinie się przy najechaniu

na nie myszką. Możliwym jest także przeniesienie takich

paneli  (lub  jakichkolwiek  innych  pasków  narzędzi)

z własnego  okna  progeCAD  i  umieszczenie  ich

np. na drugim monitorze.

Panelami można dowolnie manipulować i osadzić jeden pod drugim w jednej kolumnie. Tak

osadzone panele można również minimalizować i w ten sposób wytworzyć dwie rozwijane zakładki

(wzajemnie się przykrywające w zależności od tego, na której jest umieszczony kursor). Na rycinie

można zobaczyć rozwinięty panel  Własności i  schowany pod nim panel  Menedżer  właściwości

warstwy.

Do manipulacji panelami i oknami służą przyciski w ich prawym/lewym górnym rogu

(przy osadzaniu we własnym oknie progeCAD są one skryte i pojawiają się po najechaniu

kursorem). 
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5.3.  Rozpoczęcie nowego rysunku

Przy tworzeniu  nowego  wykresu  możesz  spotkać  się  z  kreatorem nowego  rysunku.  Kreator

zawiera nowe „puste“ wykresy, szablony ze zdefiniowanymi formatami i ramkami oraz pomocnika,

który poprowadzi po wyborze między szablonami i wykresami. 

Jeśli w polu wyboru nie pokazują się żadne szablony, oznacza to najprawdopodobniej, że zostało

błędnie  ustawione  miejsce  ich  umieszczenia.  Nastawienia  możesz  trwale  zmienić  w  menu

rozwijalnym  Narzędzia  → Opcje → Ścieżki/Pliki i  zmienić  ścieżkę  Szablony na  odpowiednią

wg używanego systemu operacyjnego:

dla Windows XP:

C:\Documents and Settings\użytkownik\AppData\progeSOFT\progeCAD\R14\Professional – Polish

\templates

pro Windows Vista, 7 a 8:

C:\Users\użytkownik\AppData\Roaming\progeSOFT\progeCAD\R14\Professional – Polish\templat

es

5.4.  Orientacja w przestrzeni wykresu

ProgeCAD jest  programem  do  rysunku  2D  i  3D.  Większość

użytkowników  będzie  najprawdopodobniej  wykorzystywać  przeważnie

rysunek 2D.

Do ruchu w przestrzeni 3D wykorzystuje się następujące kombinacje:
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Ctrl + lewy klawisz myszy: wolna rotacja w przestrzeni
Ctrl + prawy klawisz myszy: rotacja wokół osi Z

Jeśli nie chcesz pracować w przestrzeni 3D, można kombinację Ctrl + klawisz myszy wyłączyć.

Dokonasz tego za pomocą polecenia CTRLMOUSE albo poprzez użycie górnego menu Ekspres →

Zaawansowane funkcje myszki. Po uruchomieniu komendy wprowadź wartość 0 (zero) i potwierdź

klawiszem Enter.

Na rycinie widać podstawowe ustawienia kierunku współrzędnych XYZ. Kąt w płaszczyźnie

XY mierzy się od osi X w kierunku przeciwnym do wskazówek zegara.  Przy pracy w przestrzeni

3D dobrym jest wykorzystywanie funkcji z paska  Widok.

Przy  pomocy  narzędzi  w  nim zawartych  łatwo  odnowić  widok  wyjściowy.  Funkcje  te  można

również odnaleźć w górnym menu Widok → Widoki 3D (→ Górny widok) lub uruchamiać poprzez

pasek poleceń: LUW i wybór  W.

5.5.  Wiersz poleceń

Wiersz  poleceń  służy jako narzędzie  komunikacji,  w którym program wskazuje  oczekiwane

od użytkownika działania, użytkownik natomiast wprowadza tam polecenia i wartości potrzebne

przy rysowaniu dokładnych rozmiarów czy przełączaniu ustawień wybranych poleceń. Komendy

można  wprowadzać  po  polsku,  po  angielsku  a  niektóre  także  za  pomocą  skrótów  (aliasy).

W przypadku angielskich poleceń przed komendą musi być wprowadzony znak podkreślenia "_"

(bez cudzysłowów). 

Informacja:

W przypadku skrótów mamy do czynienia z tzw. aliasami. Można je zmienić za pomocą górnego

menu  Narzędzia  →  Dostosuj  →  Menu...  →  zakładka Aliasy.  Więcej  o  ustawieniach  aliasów

znajdziesz w rozdziale 19.2.4 Własne skróty klawiszowe (aliasy).

Przykład możliwego wstawienia polecenia:

polski: LINIA
angielski: _LINE
skrót: L

Przy uruchamianiu polecenia możesz w wierszu poleceń zobaczyć zapytanie, np.: 

Kąt, Długość, <Punkt końcowy>: 
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Polecenie składa się z 2 części. Pierwsza (przed nawiasem) zawiera wypis możliwych komend

dla danej funkcji; druga (w ostrym nawiasie) natomiast wskazuje wykonanie określonego działania

przez użytkownika - wprowadzenie wartości czy określenie miejsca w polu rysunku.

Jeśli będziesz chcieć uruchomić jedną z komend danej funkcji, wprowadź do paska poleceń skrót

pożądanego polecenia.  Skróty  są oznaczone wielkimi literami. W omawianym przypadku dla

wyboru komendy Kąt należy napisać K bądź k i potwierdzić klawiszem Enter .

Kąt, Długość, <Punkt końcowy>: K i potwierdzenie klawiszem Enter .

Klawiszem Enter potwierdza się wszystkie wprowadzone polecenia do paska poleceń. Wyjątek

tworzy  przykład,  gdy  współrzędne  czy  kierunek  potwierdzisz  lewym  klawiszem  myszy  (lub

prawym ustawionym jako Enter).

Klawisz Enter nie  służy  wyłącznie  do  zatwierdzania  poleceń.  Przy  jego  pomocy  możesz

powtórzyć  ostatnie wykonane polecenie.  Uwaga! Za ostatnie polecenie uważa się także funkcję

Cofnij.

W celu  lepszego zrozumienia zagadnienia  w rozdziale 6.1 Rysowanie -  podstawowe obiekty

przedstawiono kilka podstawowych elementów stosowanych przy rysowaniu.

Informacja:

Klawiszem F2 otworzysz/zamkniesz pasek poleceń we własnym oknie.

Przy włączonym ustawieniu funkcji  Wyświetl  ofertę  poleceń (więcej  rozdział

3.1 Zalecane  ustawienia)  w czasie  uruchomionych  poleceń  będzie  pojawiać  się

okno z komendami dla danego polecenia. W tym oknie za pomocą myszy można

wybierać określone komendy, przy czym nie jest koniecznym wpisywanie skrótu

do paska poleceń. Przykład okna funkcji z komendami z boku na rycinie.

5.6.  Wprowadzanie współrzędnych

W czasie rysowania będziesz wielokrotnie precyzować współrzędne punktu,  linii,  prostokąta,

okręgu i innych. Przy wprowadzaniu współrzędnych punktu masz do wyboru dwie możliwości:

1. Do paska poleceń wpisz współrzędne w formie X,Y,Z, oddzielone przecinkiem (bez spacji).

Przy wprowadzaniu miejsc dziesiętnych używa się kropki. Przykład:

Ustawienie/Wielokrotnie/<Położenie punktu>: 10.500,20.250,0 → Enter 
2. Wprowadź punkt poprzez kliknięcie do obszaru rysunku.
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5.7.  Poruszanie się po wykresie

Przesunięcie rysunku

Aby przesunąć wykres, umieść kursor w przestrzeni roboczej i trzymając środkowy

klawisz myszy (rolkę) przesuń wykres w pożądanym kierunku po czym puść rolkę.

W czasie przesuwania rysunku pojawi się zamiast kursowa ikona ręki. W przypadku

notebooków (touchpad bez środkowego klawisza) możesz skorzystać z kombinacji:

Ctrl + Shift + prawy klawisz myszy

Zwiększanie, Zmniejszanie

Zbliżanie czy oddalanie rysunku przeprowadzisz za pomocą obrotu rolki w myszce.

W  czasie  przybliżania/oddalania  zamiast  kursora  pojawi  się  ikona  lupy.  Można

skorzystać również z kombinacji:

Ctrl + Shift + lewy klawisz myszy + ruch na górę (zwiększanie);  ruch w dół (zmniejszanie)

Przestrzeń modelowania w  progeCAD jest „nieskończona“. Użytkownikowi może się zdarzyć,

że nieumyślnie przesunie rysunek. W tej sytuacji użyj funkcji Zoom Zakres. Funkcję tę uruchomisz

dwukrotnym kliknięciem w rolkę myszy albo w panelu Standard po kliknięciu w funkcję Zakres. 
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6.  RYSOWANIE

6.1.  Rysowanie - podstawowe obiekty

(linia, prostokąt, łuk, okrąg, punkt)   

W  przypadku  tych  podstawowych  elementów  dla  lepszego  zrozumienia  pracy  z  wierszem

poleceń  zostaną  opisane  ich  możliwości.  W przypadku  elementów  bardziej  złożonych  można

wybierać z szerszego spectrum możliwości, jednakże przedstawione zostaną tylko te najważniejsze

z nich.

Wszystkie niżej opisane funkcje znajdziesz w górnym menu Rysuj.

6.1.1.  Punkt

1. W panelu Rysuj kliknij na Punkt.

2. Spoglądnij do wiersza poleceń, czego program oczekuje.

3. Ustawienie/Wielokrotnie/<Położenie punktu>: 

 a) dla zmiany ustawień wpisz U i kliknij Enter.

 b) dla wstawiania większej liczby punktów niż jeden wpisz W  i kliknij Enter.

 c) wprowadź punkt poprzez kliknięcie w przestrzeń roboczą lub wpisanie współrzędnych

w formacie X,Y,Z i kliknięcie Enter.

6.1.2.  Linia

1. W panelu Rysuj kliknij na Linia.

2. Spoglądnij do wiersza poleceń, czego program oczekuje.

3. Wskaż początek odcinka.

4. Aby wskazać punkt końcowy masz kilka możliwości:

a) wskaż  współrzędne  kliknięciem  w  przestrzeń  roboczą  lub  wprowadzeniem  danych

X,Y,Z,

b) kursorem wskazać  kierunek odcinka  (nie  klikać)  a  jednocześnie  do  wiersza  poleceń

wpisać pożądaną długość i kliknąć Enter,

c) przez  pasek  poleceń  wybrać  np.  skrót  dla  kąta  (K). Wpisać  K,  Enter,  wprowadzić

wartość kąta, Enter, wprowadzić długość, Enter,

d) do wiersza  poleceń wpisać  wartości  w formacie:  @długość_odcinka<kąt_nachylenia

(np. @150<25) i  potwierdzić poprzez Enter.
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5. Możesz  narysować  dalszy  odcinek  połączony  z  poprzednim  lub  ukończyć  za  pomocą

prawego przycisku myszy, klawisza Enter lub Esc.

6.1.3.  Prostokąt

1. W panelu Rysuj kliknij na Prostokąt.

2. Wprowadź pierwszy róg prostokąta.

3. Spoglądnij do wiersza poleceń:

Określ inny punkt narożny lub [Obszar/Wymiary/oBrót]:  

a) po wyborze  Wymiary program zapyta się o odległości w kierunkach X i Y a następnie

na orientację prostokąta w stosunku do pierwszego punktu,

b) po  wyborze  Obszar  program  prosi  o  wprowadzenie  powierzchni  oraz  strony,

na podstawie której ma wyliczyć stronę drugą.

c) wprowadź współrzędne punktu przeciwległego.

6.1.4.  Okrąg

1. W panelu Rysuj kliknij na Okrąg a następnie wybierz Okrąg środek-promień.

2. Wprowadź/zaznacz środek.

3. śreDnica/<Promień>:  wprowadź promień lub przełącz na średnicę.

Początkującym użytkownikom zalecamy wybrać tę funkcję poprzez górne menu Rysuj → Okrąg

→ (...).

6.1.5.  Łuk

W przypadku łuków istnieją podobne możliwości rysowania jak w przypadku okręgów. I w tym

przypadku polecamy początkującym wybrać sposób rysowania łuku poprzez górne menu Rysuj →

Łuk → (...).

6.2.  Wybór (oznaczanie) obiektów

Proste  rysowanie  podstawowych  obiektów  do  narysowania  całego  wykresu  nie  wystarczy.

Nastanie moment, w którym będziesz musieć obiekty poprawić, skopiować lub usunąć. W tym celu

musisz wskazać, z którymi elementami chcesz pracować.

6.2.1.  Oznaczanie obiektów

Elementy  można  oznaczyć  na  wiele  sposobów.  Poszczególne  obiekty  możesz  oznaczyć

kliknięciem,  rozciągnięciem  obszaru  wyboru  (prostokąt),  poleceniem  w  wierszu  poleceń  lub

skrótem klawiszowym.
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a) Kliknięcie – klikasz na poszczególne elementy prawym klawiszem myszy.

b) Rozciągnięcie  obszaru  wyboru  –  kliknięciem  do  przestrzeni  roboczej  wyznaczasz

przeciwległe punkty prostokąta wyboru.  Przy przeciąganiu prostokąta z  lewej  do prawej

oznaczysz wyłącznie obiekty, które będą się znajdować w całości wewnątrz prostokąta. Przy

przeciąganiu prostokąta z prawej do lewej oznaczysz  wszystkie elementy,  które prostokąt

przecina lub które znajdują się w jego wnętrzu. 

Prostokąty  wyboru  różnią  się  kolorystycznie.  W  ustawieniach  domyślnych  prostokąty

„z prawej do lewej” mają kolor zielony, natomiast „z lewej do prawej” fioletowy.

wybór z lewej do prawej wybór z prawej do lewej

c) Polecenie  WYBIERZ –  po  wprowadzeniu  komendy do wiersza  poleceń  określ  elementy

do oznaczenia.

d) Skrót klawiszowy – za pomocą Ctrl + A zaznacz wszystkie elementy wykresu.

6.2.2.  Odznaczanie obiektów (usunięcie z wyboru)

W celu odznaczenia wszystkich wybranych elementów wybierz Esc. Aby przywrócić oznaczenie

określonego elementu, wybierz Shift i kliknij na obiekt lewym klawiszem myszy.

6.2.3.  Cykliczny wybór nakładających się elementów

W przypadku,  gdy na wykresie  nałożone na siebie  są  np.  kreskowanie,  większa liczbę linii,

okręgów itp., ich wybór jest dość skomplikowany.

W takich  sytuacjach  użyteczna  jest  wbudowana  w  progeCAD  funkcja  cyklicznego wyboru

przykrywających się elementów. Funkcja jest aktywna cały czas. Jej użycie jest następujące:

1. Oznacz jeden nakrywający się obiekt (kliknięciem myszy).

2. Trzymaj naciśnięty klawisz CTRL i klikaj na przykrywające się elementy.

Informacja:

Przy częstym korzystaniu z rej  funkcji korzystniejszym jest wyłączenie poszerzonych funkcji

myszy (obracanie wykresu w przestrzeni przy kliknięciu CTRL i lewego/prawego klawisza myszy),

aby nie dochodziło do niezamierzonego obrotu wykresu.

Poszerzone funkcje myszy wyłączysz  wg instrukcji  w rozdziale  18.1 Zaawansowane funkcje

myszki.
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6.2.4.  Poprzedni wybór

Jeśli pracujesz z większą liczbą oznaczanych elementów, jest możliwym korzystanie z funkcji

poprzedniego wyboru. Można się z nią zapoznać postępując według poniższych wskazówek:

1. wybierz elementy

2. wprowadź polecenie WYBIERZ (lub _SELECT)

3. anuluj wybór klawiszem ESC

4. wprowadź polecenie WYBIERZ

5. wybierz Poprzedni wybór (skrót P)

6. potwierdź klawiszem ENTER

6.2.5.  Zmienna PICKADD

Zmienna  PICKADD określa,  czy  przyszły  oznaczony  element

zastąpi  aktualnie  oznaczony  obiekt,  czy  też  zostanie  dodany

do aktualnego zbioru oznaczonych elementów.

Przy  włączonej  zmiennej  wraz  z  klikaniem  w  poszczególne

elementy dodają się  one  do aktualnego wyboru.  Przy wyłączonej

zmiennej  natomiast  po  kliknięciu  w  element  wykresu  poprzedni

wybór zostanie zastąpiony wyłącznie nowo wybranym obiektem.

Przełączanie zmiennej można przeprowadzi za pomocą:

a) polecenia  PICKADD a  następnie wskazania  ON lub  OFF i  potwierdzeniem klawiszem

Enter,

b)

c) kliknięciem na ikonę w panelu Właściwości zmieniając stan funkcji:

•  = włączona

•  = wyłączona

6.3.  Użyteczne funkcje

Dla ułatwienia pracy z progeCAD możesz skorzystać z dalszych funkcji SKOK, SIATKA, ORTO,

BIEGUN, UCHWYT, ŚLEDZENIE,  WLC,  MOBSZAR i Dziennik wydarzeń. Ich przyciski znajdują

się  w prawym dolnym rogu programu w pasku stanu.  Klikając  w nie  włączasz  lub  wyłączasz

poszczególne funkcje.

Przy  kliknięciu  prawym  klawiszem  myszy  na  którąkolwiek  z  funkcji  pojawi  się  menu

kontekstowe (jeśli jest dostępne) z dalszymi ustawieniami dla konkretnej funkcji. Np. jeśli klikniesz
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prawym klawiszem myszy na  ŚLEDZENIE lub na zieloną ikonę dziennika wydarzeń, to będziesz

mógł  włączyć/wyłączyć  dalsze  przyciski  i  funkcje  na  pasku  stanu   (jak  np.  Aktualny  system

graficzny).

6.3.1.  SKOK i SIATKA (kratka)

Dla  lepszej  orientacji  i  komfortu

w rysowaniu w niektórych przypadkach może

pomóc wyświetlanie siatki (kratki) i skokowe

poruszanie się po niej.

Siatka  pojawia  się  na  całej  powierzchni

wykresu.  Szerokość  kratki,  wyświetlanie

głównych  i  pobocznych  linii,  ich  kolor  itp.

można zmieniać w ustawieniach. 

Aby nastawić siatkę i sposób poruszania się

po  niej,  kliknij  w  prawym  dolnym  rogu

prawym  klawiszem  myszy  w  SIATKA  lub

SKOK i  wybierz  Ustawienia.  Skok  i  siatka

mają wspólne okno dialogowe z ustawieniami.

6.3.2.  ORTO

Przy  włączonej  funkcji  ORTO program  nie  dopuści  rysować

w żadnym  innym  kierunku  niż  równolegle  do  płaszczyzn  układu

współrzędnych (co w widoku 2D oznacza rysowanie pod kątem 90°

i  jego  wielokrotności).  Przy  pracy  z  obróconym  układem

współrzędnych będziesz rysować skośnie (ale zawsze pod kątem 90°

i jego wielokrotności z uwzględnieniem nachylenia do LUW).

6.3.3.  UCHWYT

Uchwyty należą do najważniejszych funkcji progeCAD. Bez tych narzędzi nigdy nie udałoby się

za  pomocą  kursora  dokładnie  połączyć  ze  sobą  linii,  wstawić  początkowy  punkt  itd.  Zawsze

doszłoby do pewnej niedokładności. 

Funkcja UCHWYT przyciąga  wprowadzane punkty w kierunku punktów już  narysowanych.

Istnieje  kilka  możliwości  ustawień  uchwytów,  lecz  nie  jest  korzystnym  włączenie  wszystkich

jednocześnie,  gdyż  mogłoby dojść  do  błędnego uchwycenia  -  np.  gdy punkt  końcowy i  punkt

najbliższy znajdują się w małej odległości siebie.
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6.3.3.1.  Stałe uchwyty

W programie możesz włączyć stałe uchwyty, które działają prawie we wszystkich poleceniach

(istnieje  jednak  kilka  wyjątków).  Aby  ustawić  uchwyty,  kliknij  prawym  klawiszem  myszy

w prawym  dolnym  rogu  ekranu  na  pole  UCHWYT i  wybierz  Ustawienia.  Drugą  możliwością

zmiany ustawień uchwytów jest użycie paska narzędzi.

Ustawienia uchwytów

Pasek narzędzi z opisem uchwytów

A. Odsuń od punktu bazowego - umożliwia wyznaczyć punkt, od którego następnie będzie 

odliczać współrzędne względne.

B. Koniec - końcowy punkt łuku, odcinka, linii lub polilinii.

C. Symetria - połowa odcinka lub łuku.

D. Przecięcie - przecięcie linii, łuków i obiektów na płaszczyźnie.

E. Pozorne przecięcie - punkt, w którym obiekty by się przecięły, lub punkt przecięcia 

obiektów w różnych płaszczyznach.

F. Centrum - środek łuku, okręgu i elipsy. Bez aktywnych pozostałych uchwytów wystarczy 

kursorem wskazać bezpośrednio na łuk, okręg lub elipsę.

G. Kwadrant - punkty na okręgu, łuku lub elipsie odpowiadające 0, 90, 180 i 270 stopniom.
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H. Styczny - styczny uchwyt do okręgu, łuku lub elipsy. Można go wykorzystać i dla wspólnej 

stycznej dwóch okręgów.

I. Prostopadły - prostopadły uchwyt z ostatniego wprowadzonego punktu do wybranego 

obiektu.

J. Równoległy - dla rysowania równoległej linii do już istniejącego odcinka.

K. Baza - punkt wstawiania bloku lub tekstu.

L. Punkt - przyciąganie do punktów (węzłów).

M. Bliski - punkt leżący we wskazanym elemencie (np. linii) będący najbliżej kursora.

N. Brak - wyłączenie wszystkich rodzajów uchwytów na jedno kolejne kliknięcie.

O. Ustawienia uchwytów obiektu - wejście do ustawień uchwytów.

W pasku nie znajduje się uchwyt przedłużenia, ale można go znaleźć w ustawieniach uchwytów.

• Przedłużenie  - fikcyjne przedłużenie odcinka. Można wykorzystać jednocześnie większej

liczby przedłużeń w celu znalezienia pozornego ich przecięcia.

6.3.3.2.  Tymczasowy uchwyt

W programie można skorzystać również z tymczasowego uchwytu, co oznacza, że dla jednego

kolejnego  uchwycenia  punktu  ignorowane  będą  wcześniej  nastawione  uchwyty  stałe  a  użyty

zostanie  tylko  jeden  konkretny  uchwyt.  Dzięki  tymczasowemu  uchwyceniu  nie  musisz  dla

jednorazowego odmiennego uchwycenia zmieniać ustawień wszystkich stałych uchwytów.

Aby aktywować tymczasowy uchwyt kliknij w czasie rysowania kombinację SHIFT + prawy

klawisz myszy. W przypadku tymczasowego uchwycenia do dyspozycji są wcześniej wymienione

uchwyty oraz jeden dodatkowy:

• Środek między dwoma punktami - służy do automatycznego wyliczenia geometrycznego 

środka między wskazanymi punktami.

6.3.3.3.  Wyświetlanie uchwytów w progeCAD

Wyżej opisane uchwyty posiadają własne symbole, które przedstawiono poniżej:
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6.3.4.  WSL (grubość linii)

W  progeCAD  Professional dla  lepszej  orientacji  w  rysunku  możesz  włączyć  lub  wyłączyć

wyświetlanie grubości linii. Aby je włączyć/wyłączyć kliknij w przycisk  WLS w prawym dolnym

rogu programu. 

Ustawienia grubości elementów – więcej rozdział 8.1 Kolor, rodzaj i szerokość linii.

6.3.5.  MOBSZAR

Tym  przyciskiem  można  przełączyć  widok  modelu  do  układu  (obszar  papieru).  W widoku

układu przycisk ten zmieni się na M:Układ lub P:Układ w zależności od aktualnie działającego

trybu.  Więcej  o  układach  znajdziesz  w  rozdziale  14 PRZESTRZEŃ  ROBOCZA  (MODEL,

UKŁAD).

6.3.6.  ŚLEDZENIE

ŚLEDZENIE   służy  do  ukierunkowania  obiektów.

Oznacza  to,  że  z  wyznaczonych  przez  użytkownika

punktów  wyświetli  linie  pomocnicze  w  określonych

kierunkach  (pod  kątami  ustalonymi  w  ustawieniach

funkcji  BIEGUN).  Przy  pomocy  tej  funkcji  masz

pewność, że nowo umieszczony punkt będzie dokładnie

nad/obok uchwyconego punktu.

Dla uzyskania oczekiwanej funkcjonalności śledzenia

muszą  być  włączone  razem  funkcje  BIEGUN,

ŚLEDZENIE i  UCHWYT.  Przy najechaniu kursorem

na  chwytany  punkt  pojawi  się  symbol  danego  uchwytu  (nie  klikaj,  przytrzymaj  kursor  nad

punktem)  a  po  chwili  na  wskazanym  punkcie  wyświetli  się  krzyżyk,  po  czym  będzie  można

z punktu poprowadzić pomocną linię.

Co  więcej  możliwa  jest  manipulacja  z  większą  liczbą  punktów  i  osiągnięcie  nakierowania

z kilku miejsc równocześnie. Np. uchwycenie w prawo od środka okręgu i zarówno nad połową

odcinka - powyższy więcej obrazek.
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6.3.7.  BIEGUN

Przy  włączonej  funkcji  BIEGUN

rysowane  linie  będą  ustawiać  się  pod

pewnymi  wcześniej  zdefiniowanymi

kątami.  W podstawowych  ustawieniach

kąt ten wynosi 90° i jego wielokrotność -

poprzez  ich  zmianę  można  dostosować

wartość  kąta,  ewentualni  dodać  kąty

uzupełniające.  Wówczas  linie  ustawiać

się będą pod kątem podstawowym i jego

wielokrotnościom  oraz  kątem

uzupełniającym. Pod wielokrotnością kąta uzupełniającego linie już się nie ustawiają.

Aby  zmienić  ustawienia  funkcji  BIEGUN, kliknij  prawym  klawiszem  myszy  w  przycisk

i wybierz  Ustawienia....  Następnie  wpisz  oczekiwaną  wartość  kąta  oraz  ewentualnie  kąty

dodatkowe.

W ustawieniach  opcji  BIEGUN  znaleźć  możesz  i  śledzenie  obiektów  (śledzenie  wyłącznie

prostopadle lub według wszystkich użytych kątów) oraz ustawienia biegunowego wymierzania kąta

(absolutne lub względne do ostatniego kąta).

6.3.8.  Dziennik wydarzeń (Notification manager)

Podczas pracy w progeCAD Professional w prawym

dolnym  rogu  pojawia  się  koperta  oraz  chmurka

z powiadomieniem.  W  ten  sposób  progeCAD

informuje  użytkownika  o  konieczności  wykonania

pewnych  zadań,   jakimi  są  np.  Regeneruj,  Odnów,

ewentualnie konieczność restartowania progeCAD.

Jeśli nie chcesz, aby te powiadomienia się wyświetlały, to kliknij na tę ikonę prawym klawiszem

myszy i odznacz Notification Manager. Wówczas przy pracy nie będzie pojawiać się ani koperta ani

chmurka z nowymi powiadomieniami.

Aby  ponownie  uaktywnić  wyświetlanie  powiadomień,  kliknij  prawym  klawiszem  myszy

na pasek stanu (np. w lewo od współrzędnych kursora) i ponownie oznacz Notification Manager. 
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6.4.  Rysowanie – pozostałe obiekty

   

6.4.1.  Linia konstrukcyjna

Linia  konstrukcyjna  jest  pomocniczą  prostą  wykorzystywaną  przy  rysowaniu.  Może  być

wytworzona jako jako dwusieczna kąta, pozioma, pionowa, pod określonym kątem lub równoległa.

Nieskończona linia: PoDział/POziomo/PIonowo/Kąt/oDsunięcie/<Punkt wzdłuż

linii>: 

6.4.2.  Polilinia

Ma charakter  kombinacji  odcinków i  łuków.  Wszystkie  linie  tworzą  jeden  element  i  muszą

na siebie nawiązywać. Polilinia może być otwarta (z jednym początkiem i końcem) lub zamknięta.

W wierszu poleceń przełączasz rysowanie w trybie linii i łuku.

łUk/Zamknij/odleGłość/ślEdź/Połowiczna szerokość/Szerokość/Cofnij/<Nastę

pny punkt>: 
Kąt/śrOdek/Zamknij/kIerunek/Połowiczna szerokość/Linia/pRomień/Drugi pun

kt/Szerokość/Cofnij/<Koniec łuku>:

Polilinię można stworzyć także z już istniejących linii i łuków. Muszą się one jednak wzajemnie

stykać w końcowych punktach.  Procedurę zmiany znajdziesz w rozdziale  7.3.3 Edycja polilinii

(połączenie linii i łuków w polilinię).

6.4.3.  Wielobok

W podstawowych ustawieniach wielobok zdefiniujesz poprzez wprowadzenie liczby boków oraz

punktów początkowego i końcowego jednego z nich. Pozostałe punkty progeCAD wyznaczy sam.

Jeśli potrzebujesz wykorzystać szczegółowe zdefiniowanie wieloboku, wybierz w wierszu poleceń

Wielokrotnie. W tych nastawieniach wprowadź liczbę stron, określ  czy wielobok ma być wpisany

w  okrąg  (definiuje  się  środek-wierzchołek)  lub  opisany  na  okręgu  (definiuje  się  środek

i prostopadłą do krawędzi).

Polecenie:  _POLYGON
Wielobok: Wielokrotnie/Szerokość linii/<Ilość stron> <4>: w

Wielobok: Szerokość linii/<Ilość stron> <4>: _EWielobok może mieć od 3 
do 1024 boków.

Wielobok: Szerokość linii/<Ilość stron> <4>: 6
Określ środek wieloboku lub [Krawędź]: (wprowadzenie punktu kliknięciem)

Podaj opcję [Wpisany do okręgu/Opisany koło okręgu] <Opisany>: w
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  Wielobok wpisany     Wielobok opisany

6.4.4.  Chmurka wersji

Służy np. do zwyraźnienia zmian na rysunku.

6.4.5.  Splajn

W przypadku krzywej  stopniowo wprowadza punkty kierunkowe.  Aby zakończyć  rysowanie

krzywej kilkukrotnie kliknij prawym klawiszem myszy. Aby stworzyć zamknięte krzywe skorzystaj

w wierszu poleceń z komendy Zamknij (Z).

6.4.6.  Elipsa

W  podstawowych  ustawieniach  (oś-oś)  wyznacza  końcowe  punkty  pierwszej  osi  elipsy

(orientację)  i  koniec  drugiej  osi  elipsy  (spłaszczenie).  Pozostałymi  możliwościami  rysowania

są oś – obrót, środek – osie i środek – obrót.

6.4.7.  Łuk eliptyczny

Postać  elipsy,  przy  rysowaniu  której  wymagane  jest  wskazanie  początkowego  i  końcowego

punktu łuku.

6.4.8.  Mlinia (multilinia)

Mlinia służy do rysowania jednej  lub  kilku  równoległych linii  ze  zdefiniowanym odstępem,

kolorem, typem, zakończeniem i  wypełnieniem. Można ją wykorzystać np. do rysowania ścian

budynków, przewodów elektrycznych, instalacji wodnych itp.

Funkcję  można  znaleźć  w  górnym  pasku  w  zakładce  Rysuj  → Multilinia lub  wywołać

poleceniem  MLINIA.  Styl  multilinii  można  definiować  i  modyfikować  za  pomocą  funkcji
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Format → Styl Multilinii... Opis ustawień stylu multilinii można znaleźć w rozdziale 7.4 Zmiana –

styl multilinii .

Aby  zmienić  styl  multilinii  na  inny  już  zdefiniowany  styl,  należy  wykorzystać  w  wierszu

poleceń przy komendzie MLINIA skrót T (sTyl) i wprowadzić nazwę oczekiwanego stylu.

Możliwą jest także zmiana skali multilinii lub wyrównania. Przy pomocy polecenia Justowanie

(J) możesz zdefiniować czy linia ma rysować się od kursora na górę, w dół lub wokół kursowa

(zerowe wyrównanie) - więcej poniższy przykład z wiersza poleceń.

Polecenie:  _MLINE

Aktualne ustawienie: Justowanie = Góra, Skala = 20.0000, Styl = STANDARD
Określ punkt początkowy lub [Wczytaj styl/Justowanie/Skala/sTyl]: s

Podaj skalę multilinii <20.0000>: 10
Aktualne ustawienie: Justowanie = Góra, Skala = 10.0000, Styl = STANDARD

Określ punkt początkowy lub [Wczytaj styl/Justowanie/Skala/sTyl]: 
Następny punkt: 

Określ następny punkt lub [Cofnij]:

6.4.9.  Kreskowanie i wypełnienie (gradient)

6.4.9.1.  Kreskowanie

Po uruchomieniu użyj ikony  w górnym pasku menu Rysuj lub poleceniem _BHATCH.

Po uruchomieniu funkcji  pojawi się okno, w którym określa się  Obwiednie,  Typ i  wzór, Kąt

i skalę. W sekcji  Obwiednie kliknij  Dodaj: Wskaż punkty  (lub Dodaj: Wybierz obiekty), następnie

kliknij w obszar, który chcesz zakreskować (można wybrać i więcej pól), i potwierdź klawiszem

Enter.

W sekcji  Typ i wzór możesz ustawić typ kreskowania (wzór) oraz kolor szrafowania. W sekcji

Kąt i skala ustaw pożądane właściwości. Później kliknij w oknie dialogowym w OK.

Informacja: 

Za pomocą przycisku   w prawym dolnym rogu możesz ustawić poszerzone właściwości,

jakimi są przykrywanie tekstu, możliwości obwiedni, wykrywanie krawędzi czy tolerancja (jaką

maksymalną przerwę między liniami program ma ignorować) szrafowania.

Aby zmienić kreskowanie poklikaj lewym klawiszem myszy

lub

oznacz kreskowanie i po kliknięciu prawym klawiszem myszy wybierz Edytuj kreskowanie

lub

Modyfikuj → Obiekt → Edytuj kreskowanie.
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6.4.9.2.  Wypełnienie (gradient)

Wypełnianie  (przejście  kolorów)  działa  podobnie  jak

kreskowanie.  Po  włączeniu  funkcji  pojawi  się  podobne

okno jak przy kreskowaniu. Zamiast rodzaju szraf, ich skali

itd,  ustawia  się  kolory  oraz  rodzaj  i  kąt.  Poszerzone

ustawienia po kliknięciu w przycisk  pozostają te same.

Aby uruchomić  gradient  użyj  ikony   w pasku  Rysuj,  górnego menu  Rysuj  lub  polecenie

_GRADIENT

Zmiana wypełnienia funkcjonuje podobnie jak edycja kreskowania.

Informacja:

progeCAD  wykorzystuje  jedno  okno  dialogowe  dla  kreskowania  i  wypełniania  -  funkcje

te przełącza się za pomocą zakładki.

Jeśli będziesz zmieniać istniejące kreskowanie i przełączysz na zakładkę Wypełnienie, szrafura

zmieni się w gradient. Podobnie możliwym jest przełączenie w drugą stronę - z przejścia kolorów

na kreskowanie.

6.4.10.  Obszar

Obszar  służy  do  połączenia  wzajemnie  dotykających  się  linii

w jeden  element  (w  podobny  sposób  tworzony  jest  prostokąt,

wielobok). Obszar można utworzyć tylko z elementów (linii i łuków),

które tworzą zamknięty kształt, tzn. żaden koniec nie będzie otwarty

a linie nie będą się rozgałęziać. Jeśli zostanie oznaczonych kilka tego

typu obiektów, to powstanie więcej obszarów. Przy pomocy punktów

chwytnych obszaru zmienia się jego pozycję, a nie kształt.

1. Oznacz stykające się linie
2. Uruchom funkcję.

Aby  powtórnie  rozłożyć  obszar  w  linie,  użyj  funkcji  Rozbij 

w pasku  Zmiana albo w górnym menu  Modyfikuj → Rozbij; (więcej

rozdział 7.2.18 Rozbij).

Na rysunku po prawej przedstawiono różnicę między zaznaczonym

obszarem a zaznaczonymi liniami w identycznym układzie.
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6.4.11.  Grupa

Grupa ma podobne działanie jak funkcja Obszar, jednakże możliwym jest połączenie wszystkich

elementów  (linie,  tekst,  wymiary  itd.)  w  ramach  jednej  grupy.  Po  kliknięciu  w  grupę  zostaną

zaznaczone  wszystkie  obiekty  w  grupie  i  wyświetlą  się  punkty  uchwytów  jak  w  przypadku

samodzielnych linii. Kształt grupy można zmieniać za pomocą punktów uchwytów.

Stworzenie grupy:

1. Oznacz obiekty do zgrupowania.
2. Kliknij prawym klawiszem myszy do przestrzeni roboczej.
3. Wybierz opcję Grupa.

Rozbij grupę:

1. Kliknij w grupę prawym klawiszem myszy.
2. Wybierz Rozbij grupę.

Przegląd  już  wytworzonych  grup  uzyskasz  w  górnym  menu

Modyfikuj → Grupa...

6.4.12.  Przykryj (Wipeout, pusty obszar) 

Bardzo użyteczne narzędzie, które umożliwi ukryć niechciane czy niepotrzebne części wykresu.

Używa się go najczęściej  w połączeniu z  przedstawianiem zewnętrznych referencji  oraz rzutni.

Zakryta przestrzeń może mieć dowolny kształt.

Funkcję uruchomisz w menu Rysuj → Przykryj

lub

poleceniem PRZYKRYJ lub _WIPEOUT i potwierdzeniem poprzez Enter.

Włączenie/wyłączenie ramki:

1. Wpisz polecenie _WIPEOUT i potwierdź klawiszem Enter.
2. Wybierz R i potwierdź klawiszem Enter.
3. Aby włączyć, napisz ON; aby wyłączyć, wprowadź OFF i potwierdź klawiszem Enter.
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6.4.13.  Tekst

W  progeCAD są dostępne dwa rodzaje  tekstu:  tekst  jednowierszowy i  tekst  wielowierszowy

(multitext). Oba rodzaje znajdziesz w menu Rysuj → Tekst lub w pasku Tekst.

6.4.13.1.  Tekst jednowierszowy

Służy do tworzenia prostych notatek i opisów. Funkcję można uruchomić poprzez górne menu

lub  poleceniami:  TEKST,  DTEKST, _TEXT,  _DTEXT.  Po  uruchomieniu  funkcji  określ  punkt

początkowy, wielkość i kierunek (kąt) tekstu oraz sam tekst. Po wprowadzeniu tekstu i kliknięciu

Enter rozpocznie się pisanie w wierszu pod wcześniejszym tekstem. Jeśli w ten sposób będziesz

kontynuować pisanie, zostaną wytworzone dalsze osobne teksty jednowierszowe. Jeśli nie chcesz

dodawać dalszego tekstu, to kliknij ponownie Enter.

Samo  polecenie  Tekst zawiera  dalsze  ustawienia  jak  styl,  różne  rodzaje  wyrównania  czy

wyśrodkowania. Te ustawienia można zmienić przed określeniem punktu początkowego wstawiania

tekstu.

Polecenie:  TEKST

Tekst: Styl/Wyrównaj/Dostosuj/na środek pIonowo/na środek 
pOziomo/Prawy/wYrównania/<Punkt początkowy>: 

Wysokość tekstu <2.5>: 5
Kąt obrotu tekstu <0>: 0

Tekst: tekst, tekst, tekst
Tekst: 

Polecenie:  

6.4.13.2.  Zmiana stylu tekstu

Aby  zmienić  styl  tekstu  jednowierszowego  wykorzystaj  funkcję  Styl  tekstu  –  Przegląd....

Aktualny styl jest widoczny w pasku Styl.

Funkcję uruchomisz:

a) w menu Format → Styl tekstu…,
b) w pasku narzędzi Styl,
c) poleceniem PISMO lub _FONT.

W tym oknie dialogowym możesz utworzyć nowy styl tekstu, określić rodzaj czcionki, wielkość

i kąt tekstu oraz pozostałe możliwości. Styl tekstu można wykorzystać także do zmiany stylu tekstu

wymiarów. Do domyślnego tekstu wymiarów jest użyty styl Standard.
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6.4.13.3.  Tekst wielorzędowy (mtext, multitext)

Służy do wprowadzania dłuższych tekstów. W tym przypadku możesz ustawić różne kolory,

wielkość i  rodzaj czcionki.  Aby uruchomić funkcję możesz wykorzystać górne menu, polecenie

MTEXT lub ikonę w pasku Rysuj.

Po  uruchomieniu  funkcji  wskaż  przeciwległe  punkty  prostokątnego  obszaru,  określające

prostokątne pole dla tekstu. Następnie otworzy się edytor tekstu wielowierszowego.

Informacja:

Po określeniu  pierwszego punktu  prostokąta  w wierszu  poleceń pojawią  się  dalsze  możliwe

ustawienia  –  justowanie,  odstępy  między  wierszami,  nachylenie,  styl,  wysokość,  kierunek,

szerokość tekstu i kolumny.

W  przypadku  użycia  funkcji  Rozbij tekst  wielowierszowy  zostanie  zmieniony

na jednowierszowy (każdy rząd stanie się jednym tekstem jednowierszowym). Czcionka wszystkich

jednowierszowych tekstów ustawi się przy tej zmianie na aktualnie ustawiony styl tekstu.

6.4.14.  Tabela

progeCAD  2014  zawiera  narzędzie  Tabela.  Ta  funkcja  umożliwia  w  progeCAD  tworzyć,

zmieniać i importować tabele z plików CSV.

↑ Powrót do spisu treści     ↑ -41- wersja 2015-01-23

http://www.progecad.pl/


Podręcznik do progeCAD 2014 Professional

6.4.14.1.  Tworzenie tabeli

Funkcję uruchomisz poleceniem TABELA, po czym pojawi się okno dialogowe do zdefiniowania

tabeli. Można tam zmienić np. opcje wstawiania (pusta tabela, tabela z wyodrębnionymi danymi

atrybutów bloków, tabela z pliku CSV), sposób wstawiania (punkt wstawiania, okno), ustawienia

kolumn i wierszy.

Aby wytworzyć tabelę postępuj wg poniższej procedury:

1. Uruchom wstawianie tabeli:

a) ikoną   na  pasku  narzędzi

Rysuj,

b) w menu Rysuj → Tabela

c) poleceniem  TABELA  (lub

_TABLE),

2. określ sposób wstawiania tabeli,

3. określ miejsce wstawienia tabeli.

Informacja

Przy tworzeniu tabeli istnieje możliwość wyodrębnienia danych o bloku i wprowadzenia w ten

sposób  uzyskanych  danych  bezpośrednio  do  tabeli,  więcej  w  dziale  13 WYODRĘBNIANIE

DANYCH.

6.4.14.2.  Edycja tabeli

Wstawioną  tabelę  można  modyfikować.  Edycję  tabeli  uruchomić  można  poleceniem

_TABEDIT lub poklikaniem w tabelę.  Następnie  pojawi się  okno dialogowe do wprowadzania

zmian.

Między komórkami poruszaj się za pomocą strzałek kierunkowych (w polu Kierunek), przycisku

Dalej lub za pomocą klawisza Enter.

• Do komórki można wstawić także tekst akapitowy (wielorzędowy). Przełączenie na tekst

wielowierszowy przeprowadza się przy pomocy przycisków  z prawej strony pola

tekstowego.

• Edycję tabeli przeprowadzisz za pomocą przeciągnięcia końcowych i rogowych punktów

lub w oknie dialogowym Edycja komórek tabeli.
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7.  MODYFIKACJA OBIEKTU
Istnieje  wiele  sposobów  modyfikacji  istniejących  już  elementów  rysunku.  W  niektórych

przypadkach szybszym może być usunięcie elementu i ponowne jego narysowanie. Kiedy indziej

wystarczy  jego  zmiana  –  rozciągnięcie,  przycięcie,  połączenie  itp..  Nie  można  jednak

jednoznacznie zalecić określonego postępowania - rozwiązanie zależy od określonego przypadku.

Do zmiany obiektu można wykorzystać mysz, funkcje zmiany lub ich kombinację.

7.1.  Modyfikacja za pomocą myszy

Za pomocą myszy można zmieniać niektóre elementy (linia, okręg, łuk, prostokąt itd.), inne zaś

wyłącznie  przesuwać  (blok,  obszar).  Przy  oznaczeniu  wielu  linii  połączonych  punktem

końcowym/początkowym,  punkt  ten  można  przesuwać,  przy  czym  zgodnemu  przesunięciu

i zmianie ulegną także oznaczone linie.  Przy oznaczeniu wielu linii  i  przesunięciu za środkowy

punkt chwytny jednej z nich dochodzi do zmiany położenia tylko tej jednej linii.

7.1.1.  Modyfikacja linii

Oznacz pożądaną linię. Po oznaczeniu na linii pojawią się trzy kwadraty i dwa trójkąty. Przykład

na poniższej ilustracji.

• Przy kliknięciu w skrajne kwadraty możliwa jest dowolna

zmiana  lokalizacji  końcowego  punktu  linii  (tym  samym

i dowolne rozciągnięcie).

• Po  kliknięciu  w  środkowy kwadrat  możliwa  jest  zmiana

pozycji linii.

• Po kliknięciu w skrajne trójkąty dochodzi do rozciągnięcia

linii w jej oryginalnym kierunku.

7.1.2.  Modyfikacja polilinii

Oznacz  pożądaną  polilinię.  Po  oznaczeniu  na  polilinii

pojawi się kilka kwadratów. Trójkąty i środkowe kwadratu w

przypadku polilinii nie pojawiają się.

Nie  jest  zatem możliwe  przesunięcie  polilinii  za  pomocą

myszy bez  użycia  dalszej  funkcji  (więcej  w rozdziale  7.2.6,

funkcja Przesuń) czy też rozciągnięcie w kierunku polilinii.
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• Przy kliknięciu w kwadraty jest  możliwa dowolna zmiana położenia końcowego punktu

odcinka (tym samym dowolne rozciągnięcie).

7.1.3.  Modyfikacja prostokąta

Zadanie:  jak  najłatwiejsza  zmiana  rozmiaru  prostokąta

(zwiększenie go).

• Kliknij  w  prostokąt  myszką.  Na  zaznaczonym  elemencie

pojawią się prostokąty.

• Kliknij  w prawy dolny kwadrat,  następnie  przesuń  kursor

poziomo  w  prawo  od  tego  punktu  (można  wykorzystać

funkcję ORTO).

• Do wiersza poleceń wprowadź wartość, o którą prostokąt ma

się przedłużyć i kliknij Enter. Wybrany punkt przesunie się o

wskazaną wartość w kierunku określonym kursorem.

• To  samo  działanie  powtórz  i  dla  prawego  górnego  rogu

prostokąta.

7.1.4.  Modyfikacja okręgu

Oznacz pożądany okrąg. Po oznaczeniu na okręgu pojawią się 4 kwadraty oraz

jeden pośrodku.

• Po kliknięciu w środkowy kwadrat  można przesuwać okrąg po obszarze

rysunku.

• Po kliknięciu w jeden ze skrajnych kwadratów dochodzi do zmian rozmiaru

okręgu.  Kursorem  pod  kątem  prostym  określisz  kierunek,  wprowadzisz

wartość (która się doda do promienia lub odejmie, gdy wybierzesz kierunek

do środka okręgu) i potwierdzisz klawiszem Enter.

Informacja:

Pozostałe elementy wykorzystują podobny sposób modyfikacji, ewentualnie łączą wyżej opisane

metody.

Promień i średnicę okręgu można także zmienić w panelu Własności.
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7.2.  Pasek Zmiana  

Pasek narzędzi  Zmiana zawiera wiele użytecznych funkcji.  Znajdują się tam funkcje  Wymaż,

Kopiuj,  Lustro,  Odsuń,  Szyk,  Przesuń,  Obrót,  Skala,  Rozciągnij,  Utnij,  Przedłuż,  Przerwij

w punkcie, Przerwij, Dołącz, Fazuj, Zaokrąglij i wspomnianą już funkcję Rozbij.

U większości tych funkcji istnieją dwie możliwości uruchomienia:

a) z oznaczonymi obiektami,

b) bez oznaczonych obiektów.

Jako przykłady będą przedstawione poniżej dokładne działania przy pierwszej opcji. Dla drugiej

tylko w przypadku potrzeby zostanie zamieszczony skrótowy opis.

7.2.1.  Wymaż

Usunie wybrane elementy lub wypisze warunki do wyboru elementów do wymazania.

1. Z oznaczonymi obiektami - uruchomieniem funkcji usunie się oznaczone elementy.

2. Bez  oznaczonych obiektów

a) uruchom funkcję z paska narzędzi,

b) wybierz elementy (klikaniem bądź prostokątem wyboru),

c) potwierdź klawiszem Enter.

7.2.2.  Kopiuj

Skopiuje  wybrane  elementy.  Po  wybraniu  obiektów  określ  punkt  bazowy,  w  odniesieniu

do którego będziesz wklejać kopie.

7.2.3.  Lustro

Wytworzy  lustrzaną  kopię  oryginalnego  elementu  według  wskazanej  osi.  Wybierz  obiekty

do lustrzanego skopiowania, wyznacz początek i koniec osi obicia, po czym odpowiedz czy usunąć

oryginalny obiekt.

7.2.4.  Odsuń (ekwidystanta)

Wytworzy kopię  wzdłuż  wybranej  linii,  obiektu  dwuwymiarowego lub  polilinii

zwiększoną/zmniejszoną o określoną odległość. 
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Po uruchomieniu funkcji określ odległość nowego elementu od oryginalnego obiektu, wybierz

kopiowane  elementy  (jeśli  nie  zostały  oznaczone  przed  uruchomieniem  funkcji)  i  kliknięciem

do przestrzeni roboczej określ stronę, na której kopia ma się wytworzyć.

Informacja:

Funkcja  Odsuń nie działa z  obszarem. W takim przypadku koniecznym jest najpierw rozbicie

obszaru.  Przy  użyciu  ekwidystanty  do  rysunku  składającego  się  z  pojedynczych  linii  musi  się

kolejno wybrać wszystkie linie, dla których wytworzy się kilka ekwidystant. Jeśli chcesz stworzyć

jedną ekwidystantę z całego rysunku, koniecznym jest połączenie linii w polilinię wg procedury

opisanej w dziale  7.3.3 Edycja polilinii (połączenie linii i łuków w polilinię).

7.2.5.  Szyk

Przy pomocy funkcji Szyk skopiujesz elementy do prostokątnego lub okrągłego pola.

7.2.5.1.  Pole prostokątne

1. Wybierz elementy do skopiowania.

2. Uruchom funkcję SZYK (poprzez górne menu bądź pasek narzędzi Zmiana).

3. Wpisz  pożądaną  liczbę  rzędów  i  kolumn  oraz  odstęp  między  rzędami  i  kolumnami.

Do określenia odstępu można wykorzystać pomocne przyciski.

4. Kliknij  na  Podgląd,  po czym w razie zadowolenia z rozmieszczenia elementów wybierz

Akceptuj. W przeciwnym razie kliknij w Edytuj.
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7.2.5.2.  Pole okrągłe

1. Wybierz elementy do skopiowania.

2. Uruchom funkcję SZYK (poprzez górne menu bądź pasek narzędzi Zmiana).

3. Przełącz na Okrągły.

4. Wskaż środek pola obrotu .

5. Określ pożądaną liczbę elementów.

6. W razie potrzeby zaznacz pole Obróć elementy.

7. Kliknij  na  Podgląd,  po czym w razie zadowolenia z rozmieszczenia elementów wybierz

Akceptuj. W przeciwnym razie kliknij w Edytuj.

7.2.6.  Przesuń

Ta  funkcja  umożliwia  przesuwanie  jednego  lub  wielu  elementów.  Po  wybraniu  elementów

i uruchomieniu funkcji określ punkt bazowy, w odniesieniu do którego elementy będą przesuwane.

7.2.7.  Obrót

Obraca elementy wokół określonego punktu pod wskazanym kątem.

Jeśli  chcesz  obrócić  obiekt  o  nieznanym  nachyleniu  do  kąta  0°

(np. aby  główne  linie  elementu  były  poziome),  możesz  wybrać  jedną

z komend  w  wierszu  poleceń  –  Referencja  (skrót  R).  Sposób  użycia

i wypis z wiersza poleceń znajdziesz poniżej.

1. Wybierz elementy

2. Uruchom funkcję Obrót

3. Wskaż punkt obrotu

4. Wybierz skrót R (referencja)

5. Wskaż pierwszy i drugi punkt linii elementu, która ma zostać obrócona

6. Wprowadź nową wartość kąta

Polecenie:  _ROTATE
1 odnaleziony

Punkt obrotu:               // wskaż kursorem punkt
Określ kąt obrotu lub [Kopiuj/Referencja]: R

Określ kąt referencyjny <0>: 
Drugi punkt: 

Punkt/Nowy kąt: 0
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7.2.8.  Skala

Służy do zmiany wielkości wybranych elementów w określonej proporcji. Funkcja ta najczęściej

będzie wykorzystywana przy zmianie skali w przekonwertowanych rysunkach z formatu PDF.

1. Wybierz zmieniane elementy.

2. Uruchom funkcję Skala.

3. Wybierz punkt odniesienia (punkt ten pozostanie na swym miejscu a wszystko pozostałe

będzie się od/do niego zmniejszać/zwiększać).

4. Do  wiersza  poleceń  wprowadź  wartość  skali  (np.  0.5 zmniejszy  obiekty  w  skali  1:2).

Nie zapomnij, że wartości dziesiętne muszą być oddzielone kropką zamiast przecinkiem.

Przykład: 

Za zadanie mamy zwiększyć odcinek na określoną długość. Obecna długość odcinka nie jest

znana. Odcinek mierzymy za pomocą wymiaru a dokładną długość odczytamy w panelu Własności.

Obecna długość odcinka wynosi np. 12.5780 mm, natomiast pożądana długość to 200 mm. Zadanie

można wykonać na dwa sposoby:

a) wyliczyć potrzebną skalę,

b) wykorzystać skalę odniesienia.

7.2.8.1.  Przeliczenie skali

pożądany rozmiar/ aktualny rozmiar = skala

200.0000 / 12,5780 = 15.900779

1. Wybierz zmieniane elementy.

2. Uruchom funkcję Skala.

3. Wybierz  punkt  odniesienia  (punkt,  który  pozostanie  niezmienny  a  pozostałe  części

obiektu/obiektów będą się od/do niego oddalać/zbliżać).

4. Do wiersza poleceń wpisz skalę 15.900779.
Pamiętaj, iż przy wstawianiu miejsc dziesiętnych zamiast przecinka należy użyć kropkę.

Informacja:

Czym mniejszy rozmiar się zwiększa, tym dokładniejszą skalę należy wprowadzić.

Przykład z wiersza poleceń:

Polecenie: _SCALE

1 odnaleziony
Punkt bazowy:              // wskaż kursorem punkt

Określ współczynnik skali lub [Kopiuj/Referencja]: 15.900779
Polecenie:
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7.2.8.2.  Skala odniesienia

Podobnie jak przy funkcji  Obrót można wykorzystać skalę odniesienia.  Nie jest  koniecznym

wyliczanie skali, a wystarczy wprowadzenie myszką dowolnych rozmiarów i następnie wskazanie

rozmiarów pożądanych.

1. Wybierz zmieniane elementy.

2. Uruchom funkcję Skala.

3. Wybierz  punkt  odniesienia  (punkt,  który  pozostanie  niezmienny  a  pozostałe  części

obiektu/obiektów będą się od/do niego oddalać/zbliżać).

4. Do wiersza poleceń wprowadź R (referencja) i potwierdź klawiszem Enter.
5. Myszką wskaż konkretną odległość (w naszym przypadku odcinek o długości 12,5780) 

poprzez kliknięcie w dwa punkty.
6. Wprowadź nowy rozmiar (w naszym przypadku wartość 200) i potwierdź klawiszem Enter.

Przykład z wiersza poleceń:

Polecenie:  _SCALE
1 odnaleziony

Punkt bazowy: // wskaż kursorem punkt
Określ współczynnik skali lub [Kopiuj/Referencja]: R

Określ długość odnośnika <1>: // wskaż pierwszy punkt
Drugi punkt: // wskaż kursorem drugi punkt

Punkt/<Określ nową długość>: 200

7.2.9.  Rozciągnij

Służy  do  przesuwania  i  naciągania  elementów.

Działanie zależy do sposobu oznaczenia. Linie, które

w całości będą się znajdować w prostokącie wyboru,

zostaną  tylko  przesunięte.  Linie,  które  przetną

prostokąt  oznaczenia  (z  prawej  do  lewej),  się

naciągną.

1. Uruchom funkcję Rozciągnij.

2. Wybierz linie, Enter.

3. Wybierz punkt odniesienia.

4. Przesuń wybrane elementy.
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7.2.10.  Utnij

Użyteczna  funkcja  Utnij umożliwia  usunięcie

nadmiernej długości linii czy linii wystającej.

1. Wybierz  obiekty,  na  podstawie  których  ma

przebiec  ucinanie  (oznaczyć  można  również

kilka obiektów).

2. Potwierdź klawiszem Enter.

3. Kliknij na obiekty, które chcesz odciąć - linie

muszą przecinać się z wcześniej wybranymi obiektami.

Informacja:

Jeśli zaraz po uruchomieniu funkcji Utnij klikniesz w prawy klawisz myszy lub naciśniesz Enter,

to  dalszymi  kliknięciami  myszy  będziesz  mógł  wycinać  poszczególne  odcinki  ograniczone

przecięciami.

7.2.11.  Wydłuż

Funkcja  Wydłuż działa  przeciwnie  do  funkcji  Utnij.  Umożliwia  ona  wydłużenie  linii

do wybranych obiektów.

1. Wybierz obiekty, do których chcesz wydłużyć linie (wybór może zawierać kilka obiektów).

2. Potwierdź klawiszem Enter.

3. Kliknij na obiekty, które chcesz wydłużyć. Linie muszą pozornie krzyżować się z wcześniej

wybranymi obiektami.

Informacja:

Jeśli zaraz po uruchomieniu funkcji  Wydłuż klikniesz w prawy klawisz myszy lub naciśniesz

Enter, to dalszymi kliknięciami myszy będziesz wydłużać linie do momentu, gdy napotkają one

inny obiekt.

7.2.12.  Przedłuż

Zmieni długość niezamkniętego elementu. Umożliwia modyfikować odcinki, krzywe, elementy

narysowane ręcznie i łuki.

Umożliwia dynamiczną zmianę, przyrost o określoną długość, przyrost o określony procent lub

przedłużenie do określonej długości całkowitej.

1. Uruchom funkcję.

2. Wybierz pożądaną opcję.
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3. Wybierz  element  kliknięciem  -  kliknięcie  w  jedną  lub  druga  połowę  obiektu  określa

kierunek przedłużenia.

4. Zakończ funkcję lub wybierz dalszy element.

7.2.13.  Przerwij w punkcie

Funkcję można wykorzystać do przerwania odcinka w określonym punkcie, przecięciu.

1. Wybierz obiekt do przerwania.

2. Wybierz punkt przerwania.

7.2.14.  Przerwij

Narzędzie  Przerwij to  połączenie  funkcji  Przerwij  w  punkcie i  Utnij.  Przerwie  ono  obiekt

w 2 punktach a pozostałą część obiektu między tymi punktami usunie.

1. Wybierz obiekt do przerwania. Tym samym kliknięciem zarówno określisz pierwszy punkt

przerwania.

2. Wybierz drugi punkt przerwania.

7.2.15.  Dołącz

Połączy nawiązujące na siebie odcinki i łuki.

1. Wybierz obiekty do złączenia (oznaczenie może zawierać kilka obiektów).

2. Potwierdź klawiszem Enter.

7.2.16.  Fazuj

Narzędzie służy do fazowania (załamywania krawędzi) dwóch przecinających się elementów.

1. Do wiersza poleceń wpisz U (Ustawienia) i kliknij Enter.

2. Otworzy  się  okno  dialogowe,  gdzie  można  nastawić  rodzaj  i  wielkość  fazowania.

Po doborze ustawień kliknij OK.

3. Kliknij  w dwa przecinające się obiekty do fazowania -  zbyteczna część będzie usunięta

(o ile w ustawieniach nie wskazano inaczej).

Przy kolejnym użyciu funkcji ustawienia będą już zapisane i będzie można bezpośrednio wybrać

elementy do załamania krawędzi (jeśli nie chce się zmienić parametrów fazowania).
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Informacja:

Jeśli w 1. kroku wprowadzisz skrót  W (Wielokrotnie), polecenie po załamaniu elementów nie

zostanie zakończone, dzięki czemu można fazować więcej obiektów bez konieczności ponownego

uruchomienia funkcji.  Funkcję w takim przypadku można ukończyć prawym klawiszem myszy,

Enterem bądź Esc.

7.2.17.  Zaokrąglaj

Zaokrągli krawędź dwóch przecinających się elementów. Działa podobnie jak funkcja Fazuj. 

1. Do wiersza poleceń napisz R (pRomień) i kliknij Enter.

2. Wprowadź pożądany promień zaokrąglenia i kliknij Enter.

3. Kliknij w dwa przecinające się obiekty do zaokrąglenia - zbyteczna część będzie usunięta

(o ile w ustawieniach nie wskazano inaczej).

Przy kolejnym użyciu funkcji ustawienia będą już zapisane i będzie można bezpośrednio wybrać

elementy do zaokrąglenia (jeśli nie chce się zmienić parametrów zaokrąglania).

Informacja:

Jeśli  w  1.  kroku  wprowadzisz  skrót  W (Wielokrotnie),  polecenie  po  przeprowadzeniu

zaokrąglenia  nie  zostanie  zakończone,  dzięki  czemu  można  zaokrąglić  więcej  obiektów  bez

konieczności  ponownego  uruchomienia  funkcji.  Funkcję  w  takim  przypadku  można  ukończyć

prawym klawiszem myszy, Enterem bądź Esc.

7.2.18.  Rozbij

O tym narzędziu wspomniano już przy opisie funkcji  Obszar. Funkcja Rozbij służy do rozbicia

obiektów 2D i 3D. Należą do nich np. prostopadłościan, ostrobok, kwadrat, obszar, wymiar, blok,

kreskowanie. 

1. Oznacz wybrane elementy do rozbicia.

2. uruchom funkcję.

7.3.  Modyfikuj – Obiekt

Edycję obiektów można znaleźć w górnym menu  Modyfikuj  → Obiekt.  Menu to umożliwia

zmianę ustawień obrazu, edycję kreskowania,  polilinii,  splajnu, tekstu wymiaru, atrybutu,  bloku

i tekstu.
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7.3.1.  Obraz

7.3.1.1.  Jakość obrazu

Modyfikuj → Obiekt → Obraz → Jakość obrazu

Funkcja umożliwia przełączanie pomiędzy wysoką i niską jakością obrazu. Jakość obrazu może

wpłynąć na płynność i czas reakcji progeCAD, ale także i na jakość finalnego dokumentu przy

wydruku.

Przełączenie jakości przeprowadzisz za pomocą wiersza poleceń.

7.3.1.2.  Ramka obrazu

Modyfikuj → Obiekt → Obraz → Ramka obrazu

Funkcja  służy  do  włączania/wyłączania  ramki  obrazu.  Przy  wyłączonej  ramce  obrazu  nie

drukuje się ona, ale jednocześnie nie ma możliwości oznaczenia samego obrazu.

7.3.2.  Edycja kreskowania

Modyfikuj → Obiekt → Edytuj kreskowanie

Po  uruchomieniu  funkcji  wybierz  szrafurę/kreskowanie,  które  chcesz  zmienić,  i  potwierdź

Enterem. Działa podobnie, jak przy poklikaniu w kreskowanie.

7.3.3.  Edycja polilinii  (połączenie linii i łuków w polilinię)

Modyfikuj → Obiekt → Edytuj polilinię

Przy użyciu tej funkcji można zmieniać różne właściwości polilinii a także wytworzyć z wielu

linii  polilinię.  Ta  funkcja  umożliwia:  edytować  wierzchołki,  zamknąć  polilinię,  usunąć

zakrzywienia polilinii, interpolację, dołączenie dalszych linii do polilinii, zmianę typu linii, obrót

kierunku polilinii, zmianę polilinii w splajn, ustawić nachylenie czy szerokość.

Na poniższym przykładzie przedstawiona jest procedura łączenia linii w polilinię:

1. Uruchom Edycję polilinii i wybierz jedną linię, która będzie częścią polilinii.

2. W wierszu  poleceń  potwierdź  zmianę  linii  w polilinię  poprzez  T (Tak)  i  zatwierdzenie

klawiszem Enter.

3. Wybierz następnie P (Połącz) i zatwierdź Enterem.

4. Oznacz wszystkie linie, które chcesz połączyć w polilinię i potwierdź klawiszem Enter (linie

muszą się wzajemnie dotykać punktami końcowymi).

5. Ukończ działanie funkcji (Enter, Esc lub prawy klawisz myszy).
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7.3.4.  Edycja splajnu

Modyfikuj → Obiekt → Edytuj splajn

Funkcja  umożliwia  zmianę  splajnu  –  np.  konwersję  na  polilinię,  obrócenie  kierunku,

przesunięcie wierzchołka, dostosowanie danych (dodanie, usunięcie wierzchołka) itd.

7.3.5.  Edycja tekstu wymiaru

Modyfikuj → Obiekt → Edytuj wymiar

Funkcja służy do odnowienia pierwotnej pozycji tekstu wymiaru (Pierwotny), przepisania tekstu

wymiaru, obrócenia tekstu lub nachylenia wymiaru pod określonym kątem.

Po  uruchomieniu  funkcji  najpierw  wybierz  określone  działanie  a  następnie  wskaż  wymiary

do zmiany.

7.3.6.  Atrybut

Zawiera klika funkcji, które służą do zmiany atrybutów bloków, pojedynczych lub wszystkich.

Procedura tworzenia bloku z atrybutami jest opisana w dziale 11.2.3 Blok z atrybutami.

7.3.6.1.  Jeden

Modyfikuj → Obiekt → Atrybut → Jeden

Wykorzystując tę funkcję zmienisz konkretny atrybut bloku. Do przeprowadzenia zmian służy

okno dialogowe, w którym można zmienić domyślne wartości atrybutu.

7.3.6.2.  Globalny

Modyfikuj → Obiekt → Atrybut → Globalny

Służy do  modyfikacji  wielu  atrybutów  bloku.

Za pomocą tej  funkcji  można zmienić położenie,

kat, tekst, czcionkę, kolor, wysokość, płaszczyznę i

przełączać  między  kolejnym  i  następnym

atrybutem bloku.

7.3.6.3.  Menedżer atrybutów bloku

Modyfikuj → Obiekt → Atrybut → Menedżer

atrybutów bloku
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Menedżer można uruchomić także poleceniem BATTMAN.

Funkcja ta posiada najwięcej możliwości zmian atrybutów. Do modyfikacji jest wykorzystywane

okno  dialogowe,  w  którym przełącza  się  pomiędzy  wszystkimi  blokami  na  rysunku  i  między

konkretnymi atrybutami.

Menedżer atrybutów bloku służy także zmianie kolejności atrybutów w bloku, nazwy, monitów,

wartości wyjściowych itd.

7.3.7.  Wytwórz blok

Modyfikuj → Obiekt → Wytwórz blok...

Służy do tworzenia nowego bloku z opisem.

7.3.8.  Edytuj tekst

Modyfikuj → Obiekt → Edytuj tekst

Służy  do  modyfikacji  wprowadzonego  tekstu.  Ta  sama  funkcja  jest  uruchamiana  przy

podwójnym kliknięciu w tekst na rysunku.

7.4.  Zmiana – styl multilinii 

Wykorzystując tę funkcję możesz wytworzyć, modyfikować, wgrać, przełączać i usuwać style

multilinii  na  rysunku.  Sposób  rysowania  multilinii  został  opisany  w  rozdziale  6.4.8 Mlinia

(multilinia).

↑ Powrót do spisu treści     ↑ -55- wersja 2015-01-23

http://www.progecad.pl/


Podręcznik do progeCAD 2014 Professional

W oknie dialogowym Styl multilinii możesz skorzystać z opcji:

• Ustaw bieżący – służy do przełączenia wybranego stylu multilinii na aktualny (aktywny

przy rysowaniu),

• Nowy... – wytworzenie nowego stylu linii,

• Zmień... –  modyfikacja  istniejącego  stylu  multilinii  (możliwa  zmiana,  wyłącznie  jeśli

w danym stylu nie została narysowana żadna multilinia),

• Zmień nazwę – zmiana nazwy stylu multilinii,

• Usuń – usuniecie wybranego stylu multilinii,

• Wczytaj... – wgranie zapisanego stylu multilinii z pliku *.mln,

• Zapisz... – zapisanie wybranego stylu multilinii do pliku *.mln,.

Przy tworzeniu nowego stylu multilinii lub przy zmianie bieżącego stylu w oknie dialogowym

definiujesz opis multilinii, zakończenie linii, łuków, wypełnienie, kolor linii, typ linii i odsunięcie

poszczególnych linii od siebie.
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8.  WŁAŚCIOŚCI OBIEKTU

8.1.  Kolor, rodzaj i szerokość linii

We wszystkich elementach w progeCAD można zmienić kolor, rodzaj linii i jej szerokość. 

Jako  domyślna  własność  elementu  jest  ustawiona  wartość   BYLAYER (według  warstwy).

To znaczy, że własności elementu będą dostosowywać się do ustawień warstwy. Jeśli elementom

tym  indywidualnie  nastawi  się  inne  wartości  (np.  kolor  czerwony,  szerokość  linii  0.50  mm),

to wartość będzie niezależna od ustawień warstwy. 

Praca z warstwami jest opisana w rozdziale 9 WARSTWY.

Ustawienia właściwości elementów znajdziesz po kliknięciu

na element w panelu „Własności“.

Jeśli  nie  panel  Własności  jest  nieaktywny,  to  włączysz

go za pomocą:

a) Ctrl + 1,

b) kliknięcia  na  element  prawym  klawiszem  myszy

i wybraniem Właściwości,

c) ikoną   Właściwości w  górnym  pasku  narzędzi

Standard.

W celu modyfikacji już narysowanych elementów należy je oznaczyć a następnie zmienić ich

własności.  Jednocześnie  można oznaczyć także  większą liczbę  elementów. Zmianę właściwości

elementu  przeprowadzisz  za  pomocą  panelu  Własności lub  w  paskach  narzędzi  Warstwa

i Właściwości elementu. Więcej na obrazku poniżej.
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Jeśli  ustawisz  określone  wartości  przed rysowaniem,  wszystkie  dalsze  elementy  będą  mieć

ustawione te same właściwości. Takie ustawienie przeprowadza się w pasku narzędzi Właściwości

elementu.

8.2.  Mierzenie długości i powierzchni

W celu szybkiego określenia długości, powierzchni lub obwodu wystarczy kliknąć na mierzony

element. Informacje to zostaną wyświetlone w panelu Własności.

Ten  sposób  dotyczy  tylko  prostych  odcinków

i powierzchni.  Aby zmierzyć  długość  większej  liczby linii

należy policzyć sumę poszczególnych zapytań lub połączyć

je  w  polilinię  -  więcej  w  rozdziale  7.3.3 Edycja  polilinii

(połączenie linii i łuków w polilinię) Następnie można już

określić  długość  polilinii.  Aby  zmierzyć  inne  elementy

należy wykorzystać dalsze funkcje.

Funkcje te są dostępne w pasku narzędzi Zapytania 

lub w górnym menu Narzędzia → Zapytania.

Znajdziesz tu mierzenie odległości między poszczególnymi punktami, mierzenie powierzchni,

parametry fizyczne, spis wszystkich znanych informacji geometrycznych o elemencie, określanie

współrzędnych poszczególnych punktów, informacje o rysunku i informacje o czasie.

Informacja:

Mierzenie  długości,  powierzchni  i  innych właściwości  elementu  można przeprowadzić  także

za pomocą  różnych  aplikacji  LISP,  SDS  lub  VBA.  Więcej  o  tych  aplikacjach  można  znaleźć

w rozdziale 19.8 Języki programowania.
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9.  WARSTWY
Warstwy zawierają elementy i określają ich właściwości (kolor, grubość, rodzaj linii itp.). Służą

do  zwiększenia  przejrzystości  wykresu  jak  przy  rysowaniu  na  przezroczystych  foliach,  które

włączaniem  i  wyłączaniem  nakłada  się  na  siebie.  Na  przykład  można  oddzielić  od  siebie

samodzielny model, osie, wymiary czy przekroje a następnie je wyłączyć, by nie przeszkadzały

przy dalszej pracy.

9.1.  Menedżer właściwości warstwy

Aby wyświetlić Menedżer właściwości warstwy:

a) kliknij na  Menedżer warstw - przegląd po lewej stronie paska narzędzi Warstwa,

b) lub wybierz w menu Format → Warstwa...

c) lub wprowadź do wiersza poleceń komendę LAYER.

W  Menedżerze  właściwości  warstw  przy  poszczególnych  warstwach  można  ustawić  nazwę

warstwy,  otwarcie/zamknięcie,  blokadę,  widoczność,  kolor,  rodzaj linii,  szerokość linii,  możliwość

wydruku i inne. Aby dokonać zmiany, należy kliknąć w określoną pozycję.

W celu dokonania szybkiej zmiany niektórych

właściwości  warstwy  można  wykorzystać  menu

rozwijalne w pasku narzędzi Warstwa.

Informacja:

Menedżer  właściwości  warstw  można  osadzić  na  skraju  okna  programu  podobnie  jak  panel

Własności - więcej w rozdziale 5.2 Osadzenie panelu Własności, managera warstw i paska poleceń.
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9.2.  Tworzenie warstwy

Warstwę tworzy się w Menedżerze właściwości warstw:

a) kliknięciem w przycisk Nowa warstwa 

b) lub  kliknięciem  prawym  klawiszem  myszy  do  głównego  pola  okna  Menedżera

właściwości warstwy i wyborem Nowa warstwa.

9.3.  Usunięcie warstwy

Usuwanie warstwy przeprowadza się przy wykorzystaniu  progeCAD Explorer. Aby uruchomić

to narzędzie  kliknij  w  menu  Narzędzia  → progeCAD  Explorer..., a  jeśli  będzie  to  konieczne,

przełącz w lewej części okna na sekcję  Warstwy. Do tego celu można wykorzystać także wiersz

poleceń i komendę EXPWAR i nacisnąć Enter.

1. Uruchom progeCAD Explorer.
2. Kliknij na warstwę a następnie na przycisk Usuń

 lub wykorzystaj  Delete na klawiaturze.
3. Klikając  w  Usuń usuniesz  warstwę  razem

z wszystkim elementami w niej się znajdującymi.
Możesz także przy użyciu opcji Zmień na i usuń
wybrać warstwę, do której elementy z usuwanej
warstwy zostaną przesunięte.

Warstwy można usuwać także z poziomu Menedżera właściwości warstwy, jednakże w ten sposób

nie jest możliwym usunięcie warstwy zawierającej obiekty.

9.4.  Wklejanie i przesuwanie obiektów do warstw

Po kliknięciu w obiekt po lewej stronie okna w panelu Własności wyświetlone zostanie, w której

warstwie element się znajduje.

Aby rysować obiekt w określonej warstwie, musisz najpierw przełączyć na pożądaną warstwę

a następnie uruchomić którąś z funkcji rysowania.

Aby przesunąć element  do innej  warstwy,  oznacz go a  następnie po lewej  stronie programu

w panelu Własności przełącz na pożądaną warstwę.
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9.5.  Zapisanie stanu warstw

W  progeCAD można zapisać a po czasie odnowić stan warstw (zablokowanie,  przymknięcie

itd.). Aby zapisać stan obecny:

a) wybierz w menu Format → Menedżer stany warstw...

b) wprowadź do wiersza poleceń LMAN.

Aby  zapisać  aktualny  stan

warstw wybierz  Zapisz i wprowadź

nazwę,  według  której  zapisane

ustawienia  odnajdziesz

i przywrócisz.

Istnieje także możliwość importu

i eksportu ustawień.

9.6.  Grupowa zmiana stanu warstw

Program  progeCAD  umożliwia  grupowe

włączenie/wyłączenie,  zamknięcie/otwarcie,

zablokowanie/odblokowanie  warstw.  Pozwala  także

klonować  obiekty,  kopiować  obiekty  do  warstwy,

przesunąć obiekt do aktualnej warstwy itd.

Wszystkie te opcje można znaleźć w menu Format →

Warstwa lub  w  pasku  narzędzi  Szybkie  narzędzie:

Warstwa.  Pasek  ten  znajduje  się  najczęściej  w  dolnej

części okna programu nad paskiem stanu.

↑ Powrót do spisu treści     ↑ -61- wersja 2015-01-23

http://www.progecad.pl/


Podręcznik do progeCAD 2014 Professional

10.  WYMIARY
Wymiarowanie  należy  do  najważniejszych  funkcji  wszystkich  projektowych  aplikacji.  Służy

do przedstawiania wielkości, tolerancji i opisu elementów rysunku.

10.1.  Style wymiarów

W progeCAD możesz zmienić domyślne właściwości wymiarów. Zmianę można przeprowadzić

dla pojedynczego wymiaru lub grupowo dla wszystkich.

Aby  zmienić  poszczególne  wymiary  możesz  wykorzystać  panel  Własności lub  poklikaniem

na wymiar uruchomić Menedżera stylu wymiarowania.

Grupową zmianę wykonać można dla wymiarów,

które  mają  ustawiony  jednakowy  styl

wymiarowania.  Aktualny  styl  wymiarowania

wyświetla się w pasku narzędzi „styl“.

Aby  zmienić  styl,  należy  wybrać  w  górnym  menu  Wymiar → Styl  wymiarowania lub

wykorzystać przycisk  w pasku narzędzi Styl.

W otworzonym w ten sposób oknie można tworzyć, usuwać, zmieniać nazwy, przepisywać style

wymiarowania  itp..  W lewej  części  okna  znajdują  się  wszystkie  wykorzystane  style,  pośrodku

podgląd wybranego stylu, natomiast po prawej przyciski do przeprowadzania zmian.

Po wybraniu stylu i kliknięciu w  Zmień... można zmieniać ustawienia grotów, formatu,  linii,

tekstu, tolerancji, jednostek i jednostek alternatywnych. Ustawienia te są rozdzielone do zakładek

i zawierają następujące pozycje:

• Linie - odstępy, przedłużenia, linie wymiarowe i pomocnicze, ich format itd.
• Symbole i strzałki - ustawienia znaczników środka, wielkości. rodzaju strzałek itd.
• Tekst - format i styl tekstu, odstęp od linii wymiarowych, wyrównanie tekstu itd.
• Dopasowanie - ustawienia wyświetlania linii i przestrzeni wokół tekstu wymiaru, 
• Jednostki podstawowe  -  ustawienia jednostek wymiarów i skal wymiarów, przedrostek,

przyrostek,
• Jednostki dodatkowe - ustawienia jednostek dodatkowych i ich tolerancja
• Tolerancja - zakres i tekst tolerancji
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10.2.  Rodzaje wymiarów

Pełny przegląd wymiarów znajdziesz w górnym menu Wymiar.  Aby przyspieszyć pracę można

także uaktywnić pasek narzędzi Wymiar.

10.2.1.  Szybki wymiar

Wykorzystywany jest przy wymiarowaniu w osi poziomej i pionowej. Po uruchomieniu funkcji

wybierz obiekty, które chcesz zwymiarować.

10.2.2.  Liniowy

Wymiarowanie  w  osi  pionowej  i  poziomej.  Określ  punkt  początkowy i  końcowy elementu

do zwymiarowania. Jeśli klikniesz prawym klawiszem myszy, to wymiarowanie liniowe przełączy

się na szybki wymiar, gdzie należy oznaczyć element do zwymiarowania i potwierdzić Enterem.

10.2.3.  Normalny (kierunkowy)

Wymiarowanie  w  osi  o  tym  samym  nachyleniu,  co  mierzony  element.  Wybierz  punkt

początkowy  i  końcowy  a  następnie  określ  odległość  linii  wymiaru  od  elementu.  Jeśli

po uruchomieniu funkcji klikniesz prawym klawiszem myszy, to będziesz mógł wybrać konkretny

element do zwymiarowania.

10.2.4.  Współrzędne

Wymiarowanie  współrzędnych  punktu.  Po  uruchomieniu  funkcji

wskaż  konkretny  punkt  -  w  zależności  od  przechylenia  linii

wymiarowej określa się daną współrzędną.

10.2.5.  Obrócony

Ma podobne działanie jak wymiarowanie liniowe.

10.2.6.  Szybka linia odniesienia

Służy do wstawiania opisów i notatek jak np. grubość blachy.

10.2.7.  Promień

Wymiarowanie  promienia  łuku  i  okręgu.  Uruchom  funkcję  i  wybierz  łuk  lub  okrąg

do wymiarowania.
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10.2.8.  Łamana

Funkcja wytworzy łamany wymiar promienia dla okręgu lub łuku.

10.2.9.  Średnica

Służy  do  wymiarowania  łuków  i  okręgów.  Po  uruchomieniu  wybierz  łuk  lub  okrąg

do zwymiarowania.

10.2.10.  Kątowy

Służy do wymiarowania kątów. Należy wybrać dwa elementy tworzące kąt.

10.2.11.  Długość łuku

Służy do wymiarowania długości łuku.

10.2.12.  Linia bazowa

Wykorzystuje się do ułatwienia wymiarowania.

1. Narysuj pierwszy wymiar (np. liniowy).
2. Uruchom  wymiarowanie  Linią  bazową,

(niekiedy  należy  oznaczyć  wymiar
początkowy).

3. Stopniowo kursorem dodawaj kolejne punkty
do wymiarowania.

10.2.13.  Wymiar łańcuchowy (kontynuuj)

Wymiary łańcuchowe służą do przyspieszenia

i ułatwienia wymiarowania.

1. Narysuj pierwszy wymiar (np. liniowy).
2. Uruchom  Wymiar  łańcuchowy,  (niekiedy

należy oznaczyć wymiar początkowy).
3. Stopniowo  kursorem  dodawaj  kolejne

punkty do wymiarowania.

10.2.14.  Tolerancja

Po uruchomieniu otworzy się okno, w którym można definiować różne wartości tolerancji. 

1. Po uruchomieniu funkcji wypełnij pola pożądanymi wartościami i kliknij OK.
2. Określ punkt wstawienia znaku tolerancji.
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10.2.15.  Znacznik środka

Niniejsze  narzędzie  wyznacza  punkt  środkowy  okręgu  lub  łuku.  Po  jego

uruchomieniu należy wybrać łuk lub okrąg.

10.2.16.  Kontrola

Umożliwia  dodanie/usunięcie  wymiaru

kontrolnego do/z wybranych wymiarów. W oknie

dialogowym  można  zmieniać  wygląd  ramki

kontrolnego wyliczenia, wartość skali kontrolnego

wyliczenia i opis.

10.2.17.  Łamanie linii wymiaru

Doda lub usunie załamanie linii wymiaru (liniowego).

Wymiar liniowy z załamaniem Wymiar liniowy bez załamania

10.3.  Asocjacja wymiarów

Wymiary mogą być asocjowane, nieasocjowane lub rozłożone. Jeśli  wymiary są asocjowane,

wówczas  dostosowują  się  zmianom  przeprowadzonym  na  zwymiarowanych  obiektach

(np. wydłużenie linii).

Asocjacja wymiarów jest nastawiana za pomocą polecenia DIMASSOC  poprzez wybór wartości

0, 1 lub 2.

Zachowanie wymiarów przy nastawionej zmiennej:

0 Wytworzy  wymiary  liniowe.  Między  elementami  wymiarów  nie  ma  żadnej  asocjacji.

Odcinki, łuki, strzałki i teksty wymiarów są rysowane jako samodzielne obiekty. 

1 Włącza nieasocjowane wymiarowanie obiektów. Elementy wymiaru są zawarte w jednym

obiekcie.  Jeśli  dojdzie  do  przesunięcia  jednego  ze  zdefiniowanych  punktów  wymiaru,

wymiar zostanie zaktualizowany.
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2 Włącza  asocjowane  wymiarowanie  obiektów.  Elementy  wymiaru  są  zawarte  w  jednym

obiekcie  a  jeden  lub  więcej  definiujących  punktów  wymiaru  jest  połączonych  ze

powiązanymi  punktami  na  obiektach  geometrycznych.  Jeśli  dojdzie  do  posunięcia

asocjowanego  punktu  geometrycznego  obiektu,  dojdzie  do  aktualizacji  umieszczenia,

orientacji i wartości wymiaru. 

10.4.  Przykład wymiarowania średnicy za pomocą wymiaru liniowego

Zadaniem  jest  zwymiarowanie  zewnętrznej  średnicy

rurki przedstawionej na rycinie obok. Tu może pojawić się

problem, gdyż w progeCAD Professional wylicza średnicę

tylko  w  przypadku  łuków  lub  okręgów.  Rozwiązanie

zagadnienia przedstawione jest poniżej.

Procedura:

1. Zwymiaruj rurkę wymiarem liniowym
2. Kliknij na wymiar.
3. V  panelu  Własności wpisz  do  przedrostka  %%C

(kategoria Jednostki podstawowe) .
4. potwierdź klawiszem Enter.

%%C - skrót dla oznaczenia średnicy
%%P - skrót dla znaku ±
%%D - skrót dla oznaczenia stopnia

Dalsze informacje o znakach specjalnych można znaleźć w rozdziale 19.5 Znaki specjalne.
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11.  BLOKI
W progeCAD znajdziesz kilka możliwości wstawiania bloków. Pierwsza z nich to bloki dostępne

w bibliotece  iCADLib,  która  zawiera  gotowe  bloki  przygotowane  przez  producenta  programu.

Drugą możliwością jest wykorzystanie własnych bloków - bloków zwykłych, bloków z atrybutami.

Dalszym rodzajem dostępnych bloków są bloki dynamiczne. Innym źródłem bloków są zewnętrzne

serwery Traceparts i CADenas dostępne poprzez managera bloków iCADLib.

11.1.  iCADLib - manager bloków

Moduł  ten  zawiera  rozległe  biblioteki  bloków z  różnych  zakresów,  takich  jak  architektura,

oznaczenia elektryczne, wyposażenie, ANSI-ISO, DIN-ISO, mechanika, 3D itd.

Aby uruchomić moduł  idź do menu  Dodatki  → iCADLib – manager bloków lub w wierszu

poleceń wpisz ICADLIB.

11.2.  Własne bloki

Jeśli  iCADLib nie zawiera często wykorzystywanych bloków, można wytworzyć swoje własne.

Blok można stworzyć dla  konkretnego rysunku i  jednorazowego użycia bądź dany blok można

umieścić w samodzielnym pliku i wklejać go do wielu rysunków. Do przeglądania i wstawiania

własnych bloków można skorzystać z managera bloków iCADLib.
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11.2.1.  Blok dla konkretnego rysunku

1. Narysuj pożądany blok.

2. Uruchom funkcję tworzenia bloków

a) ikoną   Utwórz blok… w pasku narzędzi Rysuj,

b) w menu Rysuj → Blok → Utwórz blok...,

c) poleceniem BLOK.

3. Wprowadź nazwę bloku.

4. Przyciskiem   Wybierz  obiekty  wskaż konkretne  elementy,  które  blok  będzie  zawierać

i potwierdź poprzez Enter.

5. W polu pod opcją Wybierz obiekty wskaż, co program ma wykonać z elementami.

6. Przyciskiem   Wskaż  punkt  określ  punkt  referencyjny,  w odniesieniu  do  którego  blok

będzie się wstawiało.

7. Potwierdź OK.

11.2.2.  Blok dla wielu rysunków (w samodzielnym pliku)

1. Narysuj pożądany blok.

2. Uruchom funkcję tworzenia bloków

a) w menu Rysuj→ Blok → Zapisz blok na dysk...,

b) poleceniem PISZBLOK,

3. Wybierz źródło (blok, cały rysunek, obiekty); przy wyborze całego wykresu pomiń punkty

4 i 5.

4. Przyciskiem  Wybierz obiekty wprowadź obiekty, które blok będzie zawierać. Potwierdź

klawiszem  Enter.  W polu  pod  opcją  Wybierz  obiekty wskaż,  co  program  ma  wykonać

z elementami.

5. Przyciskiem   Wskaż  punkt  określ  punkt  referencyjny,  w odniesieniu  do  którego  blok

będzie się wstawiało.

6. Wprowadź nazwę bloku.

7. Określ lokalizację i jednostki.

8. Potwierdź OK.
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11.2.3.  Blok z atrybutami

W progeCAD istnieje  możliwość

wstawienia  atrybutów  do  bloku.  Atrybut

to zdefiniowana  wartość  tekstowa,  którą

można zmieniać  (przy wstawianiu/poklikaniu

w blok).  Atrybuty  wykorzystasz  np.  przy

tworzeniu bloku z tymi samymi oznaczeniami

(np. symbol oporu, napięcia itd.), ale różnymi

opisami (wartość oporu, napięcia itd.).

1. Narysuj pożądany blok (bez zmiennych

opisów).

2. uruchom dodanie atrybutów

a) Rysuj → Blok → Zdefiniuj atrybuty…,

b) poleceniem _DDATTDEF.

3. Wprowadź nazwę atrybutu (bez przerw/spacji).

4. Wprowadź monit (progeCAD wyświetli go w wierszu poleceń jako podpowiedź/nawigację).

5. Wprowadź  tekst  domyślny  (jako  tekst  domyślny  wybierz  najczęściej  wykorzystywaną

wartość; wartość tę można przy wstawianiu bloku zmienić).

6. Określ punkt wstawienia.

7. Wybierz styl i wielkość czcionki.

8. Kliknij  na  Definiuj, aby  zdefiniować  kolejne  atrybuty,  lub  na  Definiuj  i  zakończ,  aby

zakończyć  pracę  z  atrybutami.  Jeśli  atrybut  nie  odpowiada  wyobrażeniom,  można

go przesunąć i zmienić jego właściwości w panelu Własności.

9. Następnie aby wytworzyć blok przeprowadź jedną z wcześniej  opisanych procedur, przy

czym do bloku załącz i wytworzone atrybuty poprzez ich oznaczenie.

11.2.4.  Wstawianie bloku

1. Aby wstawić blok wykorzystaj:

a) ikonu  Wstaw blok... w pasku narzędzi Rysuj,

b) menu Wstaw → Wstaw blok...,

c) polecenie _DDINSERT.

2. Jeśli  rysunek  zawiera  bloki,  możesz  wstawić  ich  kopie  poprzez  wybór  nazwy  bloku.

W innym  przypadku  koniecznym  jest  kliknięcie  w   przycisk  Przeglądaj… i  wybór

zapisanego bloku.

3. Wybierz,  czy chcesz szybko wstawić blok zaraz po kliknięciu w pole  Wstaw  (określając

następnie  ustawienia  w  przestrzeni  roboczej  i  pasku  zada),  czy  też  określić  od  razu

współrzędne, skalę i obrót.

4. Potwierdź poprzez kliknięcie w pole Wstaw.
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5. Przy  wyborze  Określ  na  ekranie wybierasz  punkt  stawiania,  skalę  X,  skalę  Y,  kąt

nachylenia,

6. Następnie pojawią się pytania dotyczące wartości atrybutów bloku.

Jeśli  progeCAD nie  będzie  zadawać  pytań  o  wartości  atrybutów  przy  wstawianiu  bloku,

konieczne będzie odnowienie ustawień progeCAD zgodnie z opisem w rozdziale  3.5 Odnowienie

domyślnych ustawień programu.

11.2.5.  Edycja bloku

Blok bez atrybutów

1. Kliknij na wstawiony blok w rysunku.

2. Potwierdź pytanie o aktywację edycji lokalnej. 

3. Po  potwierdzeniu  pojawi  się  pasek  narzędzi  Edycja

odnośnika. Za jego pomocą można dokonać zmian w

bloku.

4. Przeprowadź pożądane zmiany w bloku a następnie zapisz je klikając w przycisk  Zapisz

zmiany.

Blok z  atrybutami

1. Włącz  pasek  narzędzi  Edycja  odnośnika (według  opisu  z

rozdziału 5.1 Paski narzędzi).

2. Kliknij  w  blok  a  następnie  kliknij  na  przycisk   Edytuj

odnośniki (ewentualnie  można  wprowadzić  polecenie

_REFEDIT).

3. Potwierdź pytanie o aktywację edycji lokalnej. 

4. Przeprowadź pożądane zmiany w bloku a następnie zapisz je

klikając w przycisk  Zapisz zmiany.

11.3.  Bloki dynamiczne

Praca z blokami dynamicznymi jest (np. wstawianie, usuwanie) jest

podobna jak przy blokach klasycznych. 

Bloki dynamiczne mają tę zaletę, iż na podstawie parametru można

zmieniać ich własności (wielkość, obrót, typ wyświetlania itd.). Jako

przykłady mogą posłużyć bloki profilów czy drzwi. Aby zmienić blok
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dynamiczny,  nie  trzeba  go  rozbijać,  lecz  wystarczy  tylko  przełączyć  na  inny  rozmiar  ze

zdefiniowanej wcześniej listy.

Program progeCAD umożliwia w przypadku bloków dynamicznych zmianę ich kształtu poprzez

rozciąganie.  Zmianę  kształtu  przeprowadza  się  poprzez  przeciąganie  punktów  chwytnych

(uchwytów)  -  kwadratów  i  trójkątów.  Miedzy  zdefiniowanymi  typami  bloków  przełącza  się

za pomocą oznaczenia  lub w panelu Własności (przy oznaczonym bloku).

Informacja:

W chwili obecnej progeCAD nie umożliwia tworzenia bloków dynamicznych. W ich przypadku

można zmieniać kształt i typ z wcześniej zdefiniowanych wartości.

↑ Powrót do spisu treści     ↑ -71- wersja 2015-01-23

http://www.progecad.pl/


Podręcznik do progeCAD 2014 Professional

12.  ZEWNĘTRZNE ODNIESIENIA (XREF)
Zewnętrzne odniesienia (XRef) działają podobnie jak w przypadku bloków, jednak w porównaniu

z  nimi  mają  więcej  zalet. Za  pomocą  zewnętrznych  odniesień  można  wstawić  jeden  rysunek

do drugiego. W przypadku dalszej zmiany wstawionego rysunku zmiana pojawi się także drugim

rysunku.

W  przypadku  bloków  takie  powiązanie  nie  działa  a  każdy  blok  należy  zmienić  osobno.

Przyczyną tego jest  fakt,  iż  wstawiony blok staje  się  częścią  rysunku,  podczas  gdy  XRef przy

każdym otwarciu wczytuje obiekt ponownie ze wskazanego pliku. Z tego wynika dalsza zaleta -

rysunki  wytworzone  przy  wykorzystaniu  składni  XRef nie  obciążają  tak  komputera,  jak

ma to miejsce w przypadku wielkich rysunków, które zawierają wszystkie obiekty w jednym pliku.

Przy  pracy  z  zewnętrznymi  odniesieniami  najczęściej  będzie  się  wykorzystywać  Managera

zewnętrznych odnośników (XRef). Narzędzie to uruchamia się w menu Wstaw → Manager XRef lub

poleceniem XRM.

Manager XRef zawiera kilka funkcji - Dołącz, Odłącz, Naładuj, Rozładuj, Zwiąż, Otwórz.

12.1.  Dołączenie

1. Uruchom Managera XRef.

a) w górnym menu Wstaw → Manager XRef,

b) poleceniem XRM.

2. Kliknij na Dołącz.
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3. Znajdź i otwórz rysunek do dołączenia.

4. W następnym oknie nastaw pożądane ustawienia i potwierdź.

5. Ewentualnie  zgodnie  z  wcześniejszymi  ustawieniami  można  jeszcze  określić  punkt

wstawienia, skalę i obrót.

12.2.  Odłączenie

1. Uruchom Managera XRef.

2. Kliknij na pożądane odniesienie, które ma być odłączone.

3. Kliknij na Odłącz.

12.3.  Wgranie

Służy do ponownego wgrania uwolnionego odniesienia lub do aktualizacji obecnego odniesienia.

12.4.  Uwolnienie

Anuluje  wgranie  zewnętrznych  odniesień.  Odniesienie  nie  będzie  w  rysunku  widoczne,  ale

pozostanie wstawione i przy pomocy Managera XRef można je będzie ponownie wgrać.

12.5.  Związanie

Dotyczy połączenia odniesienia z rysunkiem. Istnieją 2 rodzaje związania:

a) Zwiąż - wstawione rysunki będą miały powiązanie z oryginalnym wykresem,

b) Wklej - zewnętrzne odniesienia wkleją się do rysunku, nowe warstwy nie będą mieć

przedrostka, a warstwy o tej samej nazwie się połączą – dojdzie do podobnego wklejania jak

w przypadku bloków.

Przy  wyborze  Wklej rysunek  zostanie  wstawiony  jako  blok  i  straci  zalety  zewnętrznego

odniesienia.

12.6.  Otwarcie

W  nowym  samodzielnym  oknie  otworzy  rysunek,  który  jest  wstawiony  jako  zewnętrzne

odniesienie.
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13.  WYODRĘBNIANIE DANYCH
Wyodrębnianie  danych  (data  extraction)  służy  do  eksportu  informacji  o  blokach  i  danych

zewnętrznych do tabeli. Tabela zawierać będzie nazwy bloków, ich liczbę, informacje geometryczne

i pozostałe.

Funkcję  można  znaleźć  w  menu  Narzędzia  → Wyodrębnij  dane lub  uruchomić  poleceniem

_EATTEXT.

1. Uruchom funkcję:

a) w menu Narzędzia → Wyodrębnij dane,

b) poleceniem _EATTEXT.

2. Wybierz pomiędzy aktualnym rysunkiem lub wybranymi obiektami i kliknij Następny.

3. W lewym  oknie  zobaczysz  bloki,  zewnętrzne  odniesienia  i  ich  liczbę;  oznacz/odznacz

pożądane bloki do wyodrębnienia.

4. Kliknij na blok i w prawym oknie oznacz/odznacz pożądane informacje do wypisania.

5. Kliknij Następny.

6. Ukończ wyodrębnianie danych

a) skorzystaj  z  przycisku  Kopiuj  dane  do  schowka  a  następnie  wklej  informacje

do programu Excel, Calc lub innej tabelkowej aplikacji,

b) kliknij Następny, wybierz plik wyjściowy i kliknij na Koniec lub na Zapisz szablon,

który możesz wykorzystać w oknie w czasie przeprowadzania punktu 2.

Informacja:

Wyodrębnianie danych jest zintegrowane bezpośrednio z funkcją Tabela. Przy tworzeniu tabeli

istnieje  możliwość  wyodrębniania  danych  bloków  i  w  ten  sposób  wyodrębnione  dane  wpisać

do tabeli.
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14.  PRZESTRZEŃ ROBOCZA (MODEL, 
UKŁAD)

W progeCAD znajdują się dwie przestrzenie. Przestrzeń robocza (model) i układ. Model rysunku

jest tylko jeden, natomiast układów może być kilka (minimalnie jednak jeden).

Przestrzeń  układu służy do przygotowania  rysunku do druku.  Można w niej  także  rysować,

wymiarować,  używać  warstw  czy  właściwości  obiektów.  W  układzie  nie  można  pracować

z przestrzenią  3D.  Do  układu  można  dodaj  jednak  rzutnie,  które  są  połączone  z  modelem

(w rzutniach tych jest już możliwą praca w przestrzeni 3D).

Wykorzystywanie układu jest  wskazane,  jeśli  z tego samego modelu będzie się  wielokrotnie

drukować różne rzutnie bądź jego części.

14.1.  Przełączanie pomiędzy modelem a układem

Aby  przejść  z  modelu  do  układu  lub

z powrotem  użyj  zakładek  w  dolnej  części

okna  pod  przestrzenią  roboczą.  Przy  dużej

liczbie zakładek dodatkowo w celu nawigacji

należy  wykorzystać  strzałki,  aby  odnaleźć

pożądaną zakładkę.

Przełączanie między przestrzenią modelu a układu jest możliwe także

przy pomocy przycisku po prawej stronie dolnego paska stanu. Przycisk

zmienia nazwę w zależności od aktywnej zakładki. Aby przełączyć należy

po kliknięciu prawym klawiszem myszy wybrać pożądaną pozycję.

Co  więcej  przy  aktywnej  zakładce  układu  można  tutaj  przełączać

rzutnie pomiędzy przestrzenią układu a modelu.

14.2.  Praca z zakładkami układu

Po  kliknięciu  prawym przyciskiem myszy w  jakąkolwiek  zakładkę  Układ pojawi  się  menu

zawierające pozycje:

• Nowy arkusz – wytworzy nową zakładkę zawierającą nowy układ.
• Z szablonu – skopiuje układ z innego rysunku.
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• Usuń – usunie wybrany układ. Nigdy nie uda się jednak usunąć ostatniego układu - zawsze
wytworzy się nowy.

• Zmień nazwę – możliwość zmiany nazwy układu.
• Kopiuj – wytworzy kopię zakładki danego układu.
• Manager ustawień strony – otworzy okno z managerem ustawień wydruku.
• Przesuń w prawo/w lewo – służy zmianie kolejności zakładek.

14.3.  Rzutnie

Rzutnie służą do projekcji modelu w układzie lub do wytworzenia

wielu „widoków” w modelu. W każdym nowym układzie wytworzona

automatycznie  jest  jedna  prostokątna  rzutnia.  Rzutnie  można

modyfikować -  zmieniać ich wielkość i pozycję.

Przed rozpoczęciem pracy z widokami dobrze jest uaktywnić pasek narzędzi Rzutnie. Pasek ten

zawiera przyciski Funkcje rzutni, Własne rzutnie i menu rozwijalne Dostosuj.

14.3.1.  Rzutnie

Tę funkcję można wykorzystać w przestrzeni modelu. Służy do zmiany układu okna na np. trzy

takie same okna pionowe.

1. Uruchom funkcję:

a) ikoną Funkcje rzutni  w pasku narzędzi Rzutnie,

b) poprzez menu Widok → Rzutnie i kliknięcie w Rzutnie ,

c) poleceniem RZUTNIA.

2. W pasku poleceń wprowadź pożądaną liczbę okien.
3. Wybierz pomiędzy pOziomo/<pIonowo>.

14.3.2.  Funkcje rzutni

Funkcja ta umożliwia wstawienie dowolnej rzutni prostokątnej do obecnego widoku - można

z niej  skorzystać  tylko  w przestrzeni  układu.  Po uruchomieniu  funkcji  wskaż  dwa przeciwległe

punkty, które wyznaczą rzutnię.

14.3.3.  Własne (poligonalne) rzutnie

W  przestrzeni  układu  istnieje  także  możliwość

wytworzenia własnych rzutni wielobocznych, kołowych

czy owalnych.
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Sposób wytworzenia własnej rzutni:

1. Narysuj  zamknięty  kształt  wykorzystując  polilinię  (po  ukończeniu  rysowania  wybierz

komendę Zamknij) - prostokąt, wielokąt, okrąg, elipsę itd.

2. Uruchom funkcję Własne rzutnie w menu Widok → Rzutnie.

3. Wybierz zamknięty element.

4. Potwierdź klawiszem Enter.

14.3.4.  Skala rzutni

Skalę rzutni można nastawić za pomocą menu rozwijalnego „Dostosuj“  w pasku

narzędzi Rzutnie lub w panelu Własności → Różne → Skala własna.

To ustawienie skali dotyczy całej przestrzeni rysunku. Określa relację długości narysowanej linii

na papierze w odniesieniu do wymiaru. Zaletą jest fakt, iż dla  każdej rzutni można ustawić  inną

skalę a jednocześnie w przestrzeni modelu posiadać rysunek w rzeczywistej wielkości (skali 1:1).

Aby zmienić skalę rzutni należy:

1. Oznaczyć zmieniany widok.

2. W menu Dostosuj wybrać skalę.

3. Jeśli  w menu nie  znajduje się  pożądana skala,  można ją  wpisać  bezpośrednio  (np.  1:3)

i kliknąć Enter.

Informacja:

Jak wyżej  wspomniano skalę rzutni można zmienić także w panelu  Właściwości. W wierszu

Skala własna wystarczy wprowadzić nową wartość i kliknąć  Enter. Np. skalę 1:4 należy zapisać

jako 0.25.

14.3.5.  Zmiana pozycji przestrzeni modelu w rzutni

Narysowane obiekty w przestrzeni modelu można przesuwać i zmieniać skalę w rzutni także

za pomocą  myszy.  W  ten  sposób  wyznaczona  skala  nie  będzie  przeważnie  zadowalać

(np. 0.135487), więc wygodniej jest ją definiować zgodnie z opisanym wyżej sposobem.

Aby przesuwać i  zmieniać  skalę  rzutni  (bez  jednoczesnego przesuwania  i  zwiększania  skali

rysunku), należy rzutnię aktywować..

Aktywowaną rzutnię rozpoznaje się dzięki oznaczeniu obramowania grubą linią
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Aktywacja rzutni:

a) podwójne kliknięcie do środka obramowania rzutni,

b) przyciskiem P:nazwa układu i kliknięciem w odpowiednią rzutnię.

Wyłączenie podglądu

a) Podwójnym kliknięciem poza obramowanie rzutni,

b) przyciskiem M:nazwa układu

Posunięcie modelu

Po aktywacji rzutni jej zawartość  zachowuje się podobnie jak w przestrzeni modelu. Dotyczy

to m.in. przesuwania, zwiększania/zmniejszania rolką w myszce, przybliżania zakresu (podwójne

kliknięcie w rolkę) i pozostałych.

Nie należy sugerować się białym tłem, podczas gdy przestrzeń modelu ma ustawiony inny kolor

tła (najczęściej czarny).

Uwaga!

Wszelkie  zmiany,  które  będą  przeprowadzone  w  aktywnej  rzutni,  zostaną  także  wykonane

w przestrzeni modelu. To oznacza, że przy usunięciu obiektu w aktywowanym podglądzie, zostanie

on usunięty także w modelu.

14.3.6.  Zamknięcie rzutni

Rzutnię można zamknąć, aby zabezpieczyć się przed

niezamierzonym  przesunięciem  już  ustawionej  rzutni.

Zamknięta w ten sposób rzutnia może zostać ponownie

aktywowana, ale jej obramowanie  w tej sytuacji zmieni

kolor na czerwony, przy czym  nie będzie możliwości

zmiany pozycji przestrzeni modelu.

Sposób zamknięcia rzutni:

1. Kliknij w rzutnię prawym klawiszem myszy.

2. W panelu Własności w kategorii Różne przełącz opcję Zamknięte wyświetlanie na Tak.

14.3.7.  Usunięcie ramki rzutni

Aby usunąć wyświetlanie  ramki należy przenieść rzutnię  do wyłączonej  warstwy.  Przestrzeń

modelu pozostanie wyświetlona, ale obramowanie zniknie.
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14.4.  Wymiarowanie

W  przestrzeni  układu  można  wykorzystać  te  same  funkcje  wymiarowania  jak  w  modelu.

Wymiary można także wstawiać przy użyciu uchwytów. Przy włączonej funkcji UCHWYT na pasku

stanu i  prawidłowym uchwyceniu wymiary mają wartości  uzyskane z  modelu. Skala rzutni  nie

odgrywa w tym miejscu roli.

Ostrzeżenie

Przy  zmianie  modelu  lub  pozycji  modelu  w  rzutni  (pozycję  można  zamknąć)  wymiary

w przestrzeni modelu się nie zmienią. Pozostaną w tym samym miejscu z pierwotną wartością

Informacja:

Jeśli  kolor  oznaczeń  uchwytów  został  zmieniony  (więcej  rozdział  3.1 Zalecane  ustawienia),

to żółte oznaczenia na białym tle mogą być słabo zauważalne.
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15.  DRUK
W progeCAD istnieją  dwa  sposoby wydruku.  Można  drukować  bezpośrednio  z  modelu  lub

z układu (layout).

15.1.  Druk z modelu

Przy drukowaniu z Modelu rysunek musisz mieć przygotowany wraz z wymiarami i pozostałymi

opisami.  Użytecznym  jest  oznaczenie  za  pomocą  prostokąta  rozmiaru/granic  papieru/obszaru

wydruku. Skalę i okno wydruku ustawia się w trakcie drukowania.

Aby przeprowadzić wydruk postępuj wg kroków:

1. Uruchom funkcję wydruk

a) ikoną Drukuj...,

b) poprzez menu Plik → Drukuj...,

c) skrótem Ctrl + P,
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d) poleceniem DRUKUJ.

2. Możesz wybrać  Ustawienia strony → nastawi wszystkie parametry druku wg zapisanych

wcześniej ustawień.

3. Wybierz Drukarkę.

4. Ustaw Rozmiar papieru.

5. Ustaw Skalę wydruku i Jednostki.

6. Ustaw Orientację rysunku.

7. Ustaw obszar wydruku (Wyświetl, Zakresy, Granice, Okno). Przy opcji Okno musisz jeszcze

wybrać obszar wydruku.

8. Wybierz opcję z pola Tabelka stylu wydruku.

9. Wybierz opcję z pola Opcje rzutni cieniowanej.

10. Ustaw Opcje wydruku – styl i grubość linii, druk w tle, pieczątka rysunku itd.

11. Ustaw pożądaną opcję przy Centruj wydruk.

12. Kliknij w Podgląd... i w przypadku, gdy wynik odpowiada Twoim wyobrażeniom, kliknij

Drukuj.

15.2.  Druk z układu

Aby drukować z układu, należy przygotować w modelu rysunek bez wymiarów i opisów (te

dodasz aż w układzie).  Przy wydruku z układu musisz nastawić każdej rzutni pożądaną skalę -

więcej w rozdziale 14.3.4 Skala rzutni.

Aby przeprowadzić wydruk postępuj wg kroków:

1. Uruchom funkcję wydruk

a) ikoną Drukuj...,

b) poprzez menu Plik → Drukuj...,

c) skrótem Ctrl + P,

d) poleceniem DRUKUJ.

2. Możesz wybrać  Ustawienia strony → nastawi wszystkie parametry druku wg zapisanych

wcześniej ustawień.

3. Wybierz Drukarkę.

4. Ustaw Rozmiar papieru.

5. Ustaw skalę wydruku 1:1 i jednostki. Skala 1:1 jest ważna, jeśli pożądaną skalę ustawiasz

w rzutniach w przestrzeni wykresu.

6. Ustaw Orientację rysunku.

7. Ustaw obszar wydruku (Wyświetl, Zakresy, Granice, Okno). Przy opcji Okno musisz jeszcze

wybrać obszar wydruku.

8. Wybierz opcję z pola Tabelka stylu wydruku.

9. Wybierz opcję z pola Opcje rzutni cieniowanej.

10. Ustaw Opcje wydruku – styl i grubość linii, druk w tle, pieczątka rysunku itd.
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11. Ustaw pożądaną opcję przy Centruj wydruk.

12. Kliknij w Podgląd... i w przypadku, gdy wynik odpowiada Twoim wyobrażeniom, kliknij

Drukuj.

15.3.  Druk rysunków do PDF i JPG

ProgeCAD umożliwia zapisanie rysunków do plików PDF lub  JPG. Przy instalacji  progeCAD

zainstalują się także dwie drukarki wirtualne – progeCAD PDF Printer 2014 oraz progeCAD JPG

Printer 2014.

Aby zapisać rysunek do PDF (JPG), należy wykorzystać te wirtualne drukarki.

Procedura jest identyczna jak przy drukowaniu na innej drukarce z tym wyjątkiem, że jej 

wynikiem jest plik PDF (JPG). Po kliknięciu w Drukuj.../OK pojawi się okno, w którym 

wskażesz ścieżkę do zapisania pliku PDF (JPG) na komputerze.
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16.  OBRAZ
progeCAD umożliwia  wstawianie  do  rysunków  obrazów.  Funkcję  tę  można  wykorzystać

np. przy  wstawianiu  różnych  znaków/logo  czy  przy  tworzeniu  wykresów  na  podkładzie

geograficznym.  Obsługiwanych  jest  szereg  formatów  obrazu  jak  JPG,  BMP,  GIF,  TIF,  PNG

i dalsze. Format  TIF  można  wyświetlić  wyłącznie,  jeśli  jest  to  obraz  bez  kompresji.  Plik  TIF

z kompresją należałoby przekonwertować do pliku TIF bez konwersji lub innego formatu.

Praca  z  obrazem  jest  podobna  jak  przy  zewnętrznych  odniesieniach,  więcej  w  rozdziale

12 ZEWNĘTRZNE ODNIESIENIA (XREF). 

W górnym menu Obraz znaleźć można kilka funkcji - są one opisane w poniższym tekście.

16.1.  Manager obrazów

W menu  Obraz znajdziesz  Manager obrazów. Posiada on te same funkcje co manager odniesień

zewnętrznych  a  ponadto  zawiera  ustawienia  jasności,  kontrastu,  ostrości,  rozmiaru,

przezroczystości itd.

Dodaj... – doda wybrany (już dołączony) obraz do rysunku.
Dołącz... – dołączy nowy obraz z dysku do rysunku.
Odłącz – odłączy obraz z rysunku (nie będzie istnieć ani odnośnik do obrazu).
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Wyładuj – wyładuje obraz z rysunku (odnośnik do obrazu i ramki obrazu pozostanie).
Naładuj – ponownie naładuje wyładowany obraz.
Przytnij... – przytnie wybrany obrazek.
Widok... – otworzy obraz w domyślnej przeglądarce/edytorze obrazu.

16.2.  Wstawianie obrazu

1. Uruchom dołączanie obrazu

a) poprzez menu Wstaw → Odnośnik do obrazu rastrowego,

b) poleceniem _imageattach.

2. Znajdź i otwórz pożądany obraz.

3. W kolejnym oknie ustaw sposób wstawiania.

4. Zgodnie  z  poprzednimi  ustawieniami  można jeszcze  określić  punkt  wstawiania,  rozmiar

i obrót.

Informacja:

W celu automatycznego pozycjonowania obrazu wykorzystaj plik z danymi dotyczącymi pozycji

(.tfw),  który zawiera wszystkie  właściwości  bitmapy,  jakimi są skala,  pozycja i  kąt  nachylenia.

Nazwa pliku musi być identyczna z nazwą obrazu. Jeśli plik ten znajduje się w tym samym folderze

co obraz, to pojawi się on w polu  Plik pozycji. W innym przypadku należy wprowadzić ścieżkę

pliku.

16.3.  Odłączenie obrazu

Jeśli obraz oznaczysz i usuniesz za pomocą klawisza DEL, nie dojdzie do jego odłączenia i nadal 

będą istnieć odnośniki do niego w rysunku. Aby prawidłowo odłączyć obraz należy:

1. Uruchomić Managera obrazów

a) poprzez menu Obraz → Manager obrazów,

b) poleceniem _image.

2. Kliknąć na pożądany obraz, który ma być odłączony

3. Kliknąć na Odłącz.

Tę  samą  procedurę  jak  przy  odłączaniu  obrazu  rastrowego  można  stosować  ze  wszystkimi

funkcjami  w  managerze  obrazów  (Dodaj...,  Dołącz...,  Odłącz,  Wyładuj,  Naładuj,  Przytnij...,

Widok... ).
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16.4.  Jakość obrazu

Umożliwia ustawienie jakości wyświetlanego obrazu. Funkcję uruchamia się za pomocą górnego

menu  Obraz → Jakość obrazu lub poleceniem  _imagequality.  Następnie wybiera się  pomiędzy

opcjami  Wysoka/Niska.

Jeśli ustawisz wyższą jakość obrazu, przełoży się ona również na trudniejszą/wolniejszą pracę

z rysunkiem.

16.5.  Ramka obrazu

Przełącza wyświetlanie ramki obrazu (wyłączona ramka nie drukuje się). Funkcję uruchomisz

w menu Obraz → Ramka obrazu lub za pomocą polecenia _IMAGEFRAME. Następnie wybiera się

pomiędzy opcjami WYłącz/Włącz.

Informacja:

Przy wyłączonej ramce obrazu nie ma możliwości oznaczenia obrazu bądź jakiejkolwiek z nim

pracy.

16.6.  Dopasuj obraz

Zmieni kąt i skalę obrazu według dwóch zdefiniowanych punktów.

16.7.  Kolejność rysowania

Za  pomocą  tej  funkcji  można  zmienić  kolejność  rysowania  nie  tylko  obrazów,  ale  także

wszystkich  elementów na  wykresie.  Po  uruchomieniu  funkcji  należy  wybrać  obiekt,  u  którego

zmienia  się  kolejność  rysowania,  po  czym  w  wierszu  poleceń  pojawiają  się  opcje:

Nad/Pod/przEdni/Tylny.

Nad/pod (obiekt) – przesunie wybrany obiekt nad/pod inny wybrany element rysunku.

Przedni/tylny – przesunie wybrany obiekt nad/pod wszystkie obiekty w rysunku.

16.8.  Przycinanie obrazu

Po uruchomieniu funkcji należy wybrać obraz do przycięcia. Po kliknięciu w obraz w wierszu

poleceń pojawiają się opcje: Włącz/Usuń/<Nowy> lub Wyłącz/Usuń/<Nowy>.

Włącz/Wyłącz – włącza/wyłącza granicę przycięcia obrazu.

Usuń – trwale usuwa granicę odcienia obszaru.

Nowy  –  uruchamia  nowe  przycięcie  obrazu,  po  czym  należy  wybrać  rodzaj  przycięcia

(prostokątne/wieloboczne).
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16.9.  Transparentność

Przełącza  ustawienia  przezroczystości  obrazu.  Funkcja

ta odnosi się do przezroczystości kanału alfa w obrazie, nie zaś

do przezroczystości całego obrazu.

Funkcję  można  uruchomić  poprzez  menu  Obraz  →

Przezroczystość,  a  następnie  należy  oznaczyć  pożądany

obrazek i wybrać jedną z opcji Włącz/WYłącz.

Na rycinie obok widać różnicę przy włączonej i wyłączonej przezroczystości.
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17.  DODATKI
progeCAD zawiera  wiele  użytecznych  dodatków,  jakimi  są  m.in.  Wektoryzacja  WinTopo,

Konwersja PDF do DWG czy połączenie z Google Earth.

17.1.  Wektoryzacja WinTopo

Służy  do  konwersji  obrazu  rastrowego  (np.  zeskanowany  rysunek,  plan  przestrzenny  itp.)

do rysunku DXF z większą bądź mniejszą dokładnością. Wynik bardzo zależy od jakości podkładu,

przy czym można spróbować go polepszyć

przy ustawieniach wektoryzacji.

Główne funkcje WinTopo:

 odczytuje bitmapowe obrazy (raster),

 identyfikuje  w  bitmapie  linie

i definiuje krawędzie,

 tworzy  monochromatyczne  wektory

ze zidentyfikowanych linii

 wyświetla  wektory  na  podkładzie

bitmapy

 otwiera wektory w progeCAD, innym

IntelliCAD bądź AutoCAD.

Procedura konwersji obrazu do wektora:

1. Uruchom WinTopo

a) poprzez menu Dodatek → Wektoryzacja WinTopo,

b) poleceniem WINTOPO.

2. Po kliknięciu w menu Plik → Open Image (Ctrl + O) wgraj obraz rastrowy.

3. Konwersję  uruchomisz  w  menu  Vector → One  Touch  Vectorisation (F10).  Ustawienia

można spróbować poprawić w menu Vector → Set One Touch Options... Po uruchomieniu

konwersja do wektora będzie wykonana.

4. Wytworzone wektory można zapisać poprzez menu  File → Save Vector As... i  otworzyć

standardowym sposobem w progeCAD.

17.2.  Konwersja PDF do DWG

progeCAD zawiera narzędzie umożliwiające konwersję wektorowych plików PDF do rysunków

DWG, które  następnie  mogą zostać  zmodyfikowane lub  służyć  jako podkład  do dalszej  pracy.
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Z wielkim stopniem dokładności konwertuje linie i  kształty.  Okręgi, łuki,  krzywe, tekst zamieni

natomiast w linie i polilinie.

Narzędzie  może być  wykorzystane wyłącznie w przypadku,  kiedy plik  PDF zawiera  grafikę

wektorową. Jeśli plik PDF zawiera zeskanowany rysunek lub inną grafikę w rastrowym formacie,

PDF zostanie wklejony do nowego rysunku DWG jako obraz. W takiej sytuacji można spróbować

przekonwertować  obraz  na  wektor  za  pomocą  narzędzia  WinTopo.  Więcej  w  rozdziale 17.1

Wektoryzacja WinTopo.

Procedura konwersji PDF do wykresu DWG:

1. Uruchom narzędzie (musi być otwarty jakikolwiek rysunek)

a) poprzez menu Dodatki → Konwertuj PDF do DWG,

b) poprzez menu Plik → Konwertuj PDF do DWG,

c) poleceniem PDF2CAD.

2. Przyciskiem   wybierz  plik  źródłowy  PDF.  W drugim  rzędzie  pojawi  się  lokalizacja

i nazwa przyszłego pliku DWG. Będzie on nazwany tak samo i umieszczony w tym samym

miejscu co plik PDF ze zmienionym wyłącznie przyrostkiem formatu na DWG. Ścieżkę

i nazwę pliku można zmienić.

3. W celu uzyskania lepszego wyniku można spróbować ustawienie nieobowiązkowych opcji

w polu  Opcje.  Na  przykład  z  plików  PDF wytworzonych  za  pomocą  eksportu można

importować także warstwy.

4. Potwierdź konwersję przyciskiem Przekształć. Zostanie ona wykonana a nowy plik  DWG

otworzy się automatycznie. Po otwarciu pliku wykorzystaj opcję  Zoom zakres (podwójne

kliknięcie rolką myszki).
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17.3.  Import widoku z Google Earth

Jeśli na komputerze zainstalowana jest aplikacja  Google Earth, to niniejszy dodatek umożliwi

automatyczne wstawienie do progeCADu obrazu przedstawiającego automatyczny widok z Google

Earth.  Funkcję  wykorzystuje  się  głównie  przy  rysowaniu  wykresów  z  podkładem  mapowym.

Obrazowi można nadać odpowiednią skalę, wstawić do zamkniętej warstwy i rysować na nim.

Procedura importu:

1. Uruchom Google Earth i znajdź pożądany teren.

2. Uruchom import obrazu

a) poprzez menu Dodatki → Import obrazu z Google Earth,

b) poleceniem ImportGEImage.

3. Do rysunku zostanie wstawiony aktualny widok z Google Earth.

17.4.  Eksport PDF 3D

Nowym dodatkiem w progeCAD 2014 Professional

jest  Eksport PDF 3D,  który umożliwia eksportowanie

brył i płaszczyzn do PDF 3D. 

Plik  PDF  3D  można  otworzyć  na  jakimkolwiek

komputerze  z  zainstalowanym  programem  Adobe

Reader XI lub nowszym.

Przed wykonaniem eksportu masz możliwość zmiany

ustawień  jak  np.:  wielkość  i  orientacja  papieru,

nagłówek  i  stopka,  wstawienie  własnego  logo,  hasła,

nastawienia  renderowania  3D  czy  połączenie  z  już

istniejącym plikiem PDF (dodanie przed, na koniec lub

wstawienie za określoną stronę).

Eksport PDF 3D można uruchomić za pomocą menu

Dodatki → Eksport do PDF 3D.

W  plikach  PDF  3D  możliwym  jest  przeglądanie,

obracanie, przybliżanie, oddalanie itd. wyeksportowanych obiektów.
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Informacja:

W menu  Dodatki  znajdziesz także  Otwórz przykładowe PDF 3D.  Ta pozycja otworzy folder

z przykładowymi rysunkami DWG zawierającymi wytworzone obiekty 3D. Rysunki te w prosty

sposób można eksportować do PDF 3D.

Przykłady plików PDF 3D znajdziesz na naszej stronie w opisie progeCAD Professional lub

pośrednio  pod  poniższym odnośnikiem (PDF należy  otworzyć  koniecznie  w  programie  Adobe

Reader XI lub nowszym):

Przykładowe pliki PDF - pobierz
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18.  NARZĘDZIA EKSPRES
Do  ekspresowych  narzędzi  należy  prawie  50  użytecznych  funkcji,  które  zwiększają

produktywność pracy przy rysowaniu. Łatwe w użyciu narzędzia, które są zawarte w menu lub

paskach narzędzi, dotyczą kilku różnych płaszczyzn, włączając zmiany bloków, tekstu, rozszerzone

funkcje myszy, wyboru czy modyfikacji obiektów.

Na przykład narzędzia do pracy z tekstem umożliwiają zamienić tekst na krzywe, zmienić tekst

w tekst wielowierszowy, otoczyć tekst ramką itd.

18.1.  Zaawansowane funkcje myszki

Funkcję uruchomisz/wyłączysz kombinacją CTRL + dowolny klawisz myszy. Umożliwia ona

obracanie rysunku w przestrzeni.

1. Uruchom funkcję

a) Ekspres → Zaawansowane funkcje myszki,

b) poleceniem _CTRLMOUSE.

2. Wprowadź wartość 0 lub 1 (wyłączone lub włączone).

3. Potwierdź klawiszem Enter.
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19.  OPCJE ZAAWANSOWANE

19.1.  Obrót LUW (lokalnego układu współrzędnych) i widoku

Przy rysowaniu  staje  się,  iż  koniecznym jest  obrót  płaszczyzny

wg tworzonego  obiektu  (np.  wykreślenie  domu  na  działce).  Przy

niniejszym  obrocie  płaszczyzny  można  rysować  prostopadłe

z nachyleniem. Obrót można wykonać na kilka sposobów.

Obsługa  układu  współrzędnych  jest  możliwa  za  pomocą  menu

Narzędzia,  gdzie  znajdują  się  funkcje  LUW  -  przegląd,

Ortometryczne  LUW  i  Nowy  LUW.  Dalsze  opcje  można  znaleźć

w paskach narzędzi  LUW i LUW II.

      

19.1.1.  Obrót LUW według obiektu

Funkcja obróci lokalny układ współrzędnych według wybranego obiektu (sam obiekt  się nie

obróci). W górnym menu wybierz  Narzędzia → Novy LUW → Obiekt,  po czym oznacz obiekt,

według którego układ współrzędnych ma się obrócić. Szybszym sposobem jest użycie ikony 

w pasku narzędzi LUW.

19.1.2.  Widok

Do pracy z  widokiem można wykorzystać funkcje takie  widoku jak np.  Posunięcie  widoku,

Domyślne  widoki,  Widoki  3D,  Powiększ, Widok  dynamiczny. Wszystkie  te  funkcje  znajdują  się

w górnym menu Widok.

Jeśli potrzebujesz obrócić cały widok (włącznie z obiektami), skorzystaj z funkcji  Sterowanie

widokiem, za pomocą której można obracać wszystkimi osiami. Jest ona dostępna w menu Widok

→ Widoki 3D → Sterowanie widokiem.

Jeśli potrzeba przełączać pomiędzy wieloma widokami, należy skorzystać z funkcji  Widok →

Nazwane  widoki  -  przegląd....  Za  jej  pomocą  można  zapisać,  zmieniać  i  przełączać  pomiędzy

zapisanymi widokami.
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19.2.  Ustawienia  pasków  narzędzi,  dodanie  ikon  i  skrótów
klawiszowych

Ułatw sobie pracę z progeCAD. Dodaj nowe ikony, ustaw nowe funkcje ikon w paskach narzędzi

i zmień skróty klawiszowe na te, do których jesteś przyzwyczajony z innych programów.

19.2.1.  Dodanie ikon do pasków narzędzi

1. Otwórz  okno dialogowe w menu  Narzędzia  → Dostosuj  → Menu... → zakładka  Paski

narzędzi.

2. W lewej kolumnie kliknij na odpowiednią kategorię.

3. W  prawo  od  niej  pojawią  się  dostępne  ikony.  Uchwyć  pożądaną  ikonę  i  przeciągnij

ją do jakiegokolwiek paska narzędzi między używane już ikony lub do wolnej przestrzeni,

aby wytworzyć nowy panel.

19.2.2.  Usuwanie ikon z pasków narzędzi

1. Otwórz Narzędzia → Dostosuj → Menu... → zakładka Paski narzędzi.

2. Aby usunąć dodaną ikonę z paska narzędzi wystarczy ją uchwycić i przesunąć poza panel

(okno dialogowe musi być w tym czasie otwarte).

19.2.3.  Zmiana funkcji ikon w paskach narzędzi

1. Znajdź skrót polecenia, który będziesz chciał przypisać określonej ikonie.

2. Otwórz  okno  dialogowe  z  menu  Narzędzia →  Dostosuj →  Menu... → zakładka  Paski

narzędzi.

3. Na otwarte  okno dialogowe nie  zwracaj  uwagi,  lecz  kliknij  na wybraną ikonę w pasku

narzędzi tak, jakbyś chciał włączyć funkcję.

4. Po kliknięciu w ikonę umożliwione zostanie dokonywanie zmian poleceń w oknie Dostosuj.

5. Zamień dotychczasowe polecenie nowym w kształcie ^C^C^C_angielskiepolecenie.

Informacja:

Polecenia  można  łączyć.  Przykład  przeprowadzania  większej  liczby  poleceń  (wraz

z parametrami poleceń) za pomocą jednego przycisku umieszczono poniżej.

Po kliknięciu jest przeprowadzone rozbicie oznaczonych elementów, audyt wykresu, po czym

włączy się okno dialogowe Druk.

Jeśli  za  polecenie  wstawisz  przerwę,  polecenie  się  uruchomi  a  dalszy  znak  przeprowadzi

przełączenie komendy (parametru polecenia).

^C^C^C_explode; ^C^C^C_audit _Y; ^C^C^C_print;
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19.2.4.  Własne skróty klawiszowe (aliasy)

1. Otwórz okno dialogowe z menu Narzędzia → Dostosuj → Menu... → Aliasy.

2. Wybierz Nowy i w polu Alias wprowadź kombinację klawiszy, którą preferujesz.

3. W prawej  kolumnie kliknij  w wybrane polecenie i  przyciskiem  Przypisz połącz ze sobą

polecenie i klawiszową sekwencję.

19.2.5.  Własne skróty klawiszowe (klawiatura)

Dla  poleceń  wywoływanych  kombinacją  klawiszy  np.  Ctrl +  litera wykorzystaj  podobną

procedurę :

1. Otwórz okno z menu Narzędzia → Dostosuj → Menu... → Klawiatura.

2. Wybierz Nowy i wprowadź kombinację klawiszy, którą preferujesz.

3. W prawej  kolumnie kliknij  w wybrane polecenie i  przyciskiem  Przypisz połącz ze sobą

polecenie i klawiszową sekwencję.

19.3.  Kolor tarczy kursora

Kolor  tarczy  kursora  można  zmienić  za  pomocą  polecenia

APERTURECOLOR i  wyboru  numeru,  który  odpowiada  konkretnej

barwie,  albo  w oknie  dialogowym otwieranym z  menu  Narzędzia →

Opcje... → Uchwyty.

Numeryczny  kod  koloru  można  znaleźć  np. w oknie  zmiany  koloru

linii/warstwy itp.

19.4.  Wielkość tarczy kursora

Istnieją  dwa  warianty  zmiany  wielkości  tarczy  kursora.  Pierwszy  wariant  obejmuje  zmianę

wielkości  tarczy  kursora  w  trakcie  rysowania (np.  przy  rysowaniu  linii).  Zmianę  tego  trybu

przeprowadza się w następujących ustawieniach:

1. Górne menu Narzędzia → Opcje... → Uchwyty.

2. Zmień wielkość znacznika uchwytu.

Aby zmienić  wielkość  tarczy krzyża  nitkowego

w trybie początkowym czy przy selekcji, należy: 

1. wprowadzić polecenie _pickbox,

2. potwierdzić klawiszem Enter,

3. wprowadzić nową wartość, np.10 (domyślnie

to 3),
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4. potwierdzić ponownie klawiszem Enter.

Ustawienie  to  można  także  zmienić  poprzez  menu  Narzędzia  → Ustawienia  rysowania →

zakładka Wklejanie współrzędnych → zmiana na Wybór obiektu → Ramka oznaczania obiektów.

19.5.  Znaki specjalne

W programie  progeCAD nie wykorzystuje się menu, pasków czy ikon do wstawiania znaków

specjalnych. Niemniej jednak za pomocą kodów można je zdefiniować lub wkleić metodą „Ctrl+C,

Ctrl+V“. Poniższa tabela przedstawia przykłady najczęściej używanych znaków specjalnych:

Kod Funkcja

%%c Symbol średnicy()

%%p Symbol plus-mínus (±)
%%d Symbol stopnia (º)
%%% Symbol procenta (%)
%%o Początek i koniec podkreślenia

Dalsze  znaki  specjalne  można  wstawiać  przy  pomocy  narzędzia  Tablica  znaków zawartego

w Windows  (Menu  start  → Akcesoria  → Narzędzia  systemowe)  lub  w  oknie  edycji  tekstu

wielowierszowego (mtekstu) - znaki specjalne można wstawić po kliknięciu do pola tekstu prawym

klawiszem myszy. W następnym menu kontekstowym są do dyspozycji pod oznaczeniem Wstaw

symbol.

19.6.  Własne rodzaje linii

19.6.1.  Proste

Proste rodzaje linii są "jednowymiarowe" i wykorzystują wyłącznie kreski, przerwy i kropki.

Własne rodzaje prostych linii możesz definiować poprzez  progeCAD Explorer  lub poleceniem _-

LINETYPE → wyTwórz....

Tworzenie rodzaju linii poprzez progeCAD Explorer:

1. Uruchom progeCAD Explorer

a) Narzędzia → progeCAD Explorer i przełącz w lewym oknie na Rodzaje linii,

b) lub poleceniem _ExpLTypes.

2. W prawym oknie Explorera poprzez prawy klawisz lub w menu Edycja wybierz  Nowy →

Rodzaj linii.

3. Pojawi się okno do zdefiniowania własnego rodzaju linii. Wprowadź nazwę rodzaju linii,

opis rodzaju linii i definicję rodzaju linii. Aby zdefiniować rodzaj linii należy dotrzymywać

niniejszych reguł:
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• Liczba dodatnia definiuje długość linii.

• Liczba ujemna definiuje długość przerwy.

• Zero definiuje kropkę.

Poszczególne wartości musisz oddzielić przecinkami. Aby przetestować rodzaj linii wprowadź

np. wartości (linia, przerwa, kropka, przerwa):

4. Kliknij "OK" i wybierz nowo utworzony typ linii. Następnie wyświetli się on w użytych

rodzajach linii:

Tworzenie własnego rodzaju linii za pomocą wiersza poleceń:

1. Do wiersza  poleceń wprowadź  _-linetype,  wybierz  T (wyTwórz) i  wpisz  nazwę nowego

rodzaju linii.

2. Wyświetli się następnie okno zapisu rodzaju linii do nowego pliku lub przyłączenia rodzaju

do dotychczasowego  pliku.  Do  dodania  nowego rodzaju  wybierz  np.  plik  ICAD.lin lub

zdefiniuj nowy plik z końcówką .lin.

3. W wierszu poleceń wstaw opis nowego rodzaju linii według własnego uznania i  kliknij

Enter.
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4. Wprowadź definicję nowego rodzaju linii wg zasad przedstawionych wyżej na przykładzie

definiowania  przez  progeCAD  Explorer.  Początkowa  litera  "A",  która  jest  nastawiona

automatycznie  oznacza,  że  rodzaj  linii  będzie  zawsze  dostosowany  między  dwoma

wierzchołkami  tak,  aby  linia  kończyła  się  przecinkiem.  Potwierdź  klawiszem  Enter

i wypróbuj rysowanie z nowym rodzajem linii.

19.6.2.  Złożone

Złożone rodzaje linii są „dwuwymiarowe” i mogą zawierać znaki tekstowe, łańcuchy danych lub

kształty ("shapes") definiowane w specjalnym pliku. Definicję linii można prowadzić przy pomocy

zmiany pliku tekstowego, w którym rodzaje linii są definiowane.

1. W  edytorze  tekstu  (np.  notatnik)  otwórz  plik  icadiso.lin, który  znajdziesz  w  folderze

ustawień użytkownika.  Folder  ten otworzysz przy pomocy Centrum progeCAD - więcej

rozdział 3.4 Centrum progeCAD.

2. Do pliku  masz  możliwość dodać  definicję  nowego rodzaju linii.  Definicja  zawiera  dwa

rzędy utworzone wg wzoru wcześniejszych linii a ich składnia jest następująca:

Rząd 1:

* (gwiazdka) - początek nowej definicji rodzaju linii

, (przecinek) - oddziela nazwę i definicję linii

_._. (opis) - opis rodzaju  linii (podkreślenia, kropki, tekst), maksymalnie 47 znaków

Rząd 2:

A - atrybut, który oznaczy początek i koniec linii przecinkiem

Liczba dodatnia - definiuje długość linii

Liczba ujemna - definiuje długość przerwy

Zero - definiuje kropkę

; (średnik) - na początku rzędu oznaczy rząd jako komentarz. Poszczególne wartości

są oddzielone przecinkami.

3. Wklejanie tekstu do linii

Częścią  rodzaju linii  może być  tekstowy łańcuch,  którego definicja  jest  zapisana

w nawiasach kwadratowych. Na przykład:

*PLOT,  Plot  ----X----X----X----X----X----X-A,1.0,-.25,

["X",STANDARD,S=.2,R=0.0,X=-0.1,Y=-0.1],-.40

"X" (tekst) - tekst wyświetlany jako część linii

"STANDART" (styl tekstu) - atrybut nieobowiązkowy; jeśli go brakuje wykorzystana

jest aktualna wartość zmiennej systemowej TextStyle
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s=.2 - definicja skali tekstu (jego wyświetlanej wielkości)

r=0.0 -  definicja  obrotu  tekstu  w  odniesieniu  do  kierunku  linii  (nieobowiązkowe).

Podstawowe wartości są w stopniach, dalszą możliwością są radiany (R=1.2r)

lub grady (R=150g).

A=0.0 - absolutna orientacja tekstu bez względy na kąt linii

X=-.1,Y=-.1 - pozycjonowanie tekstu

4. Wklejenie kształtu (shapes) do linii

Definicje  kształtów  są  także  wprowadzane  w  zawiasach  kwadratowych  i  odnoszą  się

do określonych plików. Na przykład:

*SHAPES,Shape SSS

A,.0001,[SSS,ltypeshp.shx,x=-.01,s=.02],-.0001 - wykorzysta kształt o nazwie  "SSS"

z pliku ltypeshp.shx.

Informacja:

Definicje złożonych rodzajów linii muszą zawsze zaczynać się i kończyć linią lub przerwą. Nie

jest możliwym definiowanie ich wyłącznie poprzez złożenie kształtów.

Przykładowe zapisy kilku linii:

*ZIGZAG,Zig zag /\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/\/
A,.00254,-5.08,[ZIG,ltypeshp.shx,x=-5.08,s=5.08],-10.16,

[ZIG,ltypeshp.shx,r=180,x=5.08,s=5.08],-5.08

*TRACKS,Tracks -|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-|-
A,3.81,[TRACK1,ltypeshp.shx,s=6.35],3.81

*HOT_WATER_SUPPLY,Hot water supply ---- HW ---- HW ---- HW ----

A,12.7,-5.08,["HW",STANDARD,S=2.54,R=0.0,X=-2.54,Y=-1.27],-5.08

*FENCELINE1,Fenceline circle ----0-----0----0-----0----0-----0--
A,6.35,-2.54,[CIRC1,ltypeshp.shx,x=-2.54,s=2.54],-2.54,25.4

*FENCELINE2,Fenceline square ----[]-----[]----[]-----[]----[]---

A,6.35,-2.54,[BOX,ltypeshp.shx,x=-2.54,s=2.54],-2.54,25.4

*BATTING,Batting SSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSSS
A,.00254,-2.54,[BAT,ltypeshp.shx,x=-2.54,s=2.54],-5.08,

[BAT,ltypeshp.shx,r=180,x=2.54,s=2.54],-2.54
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19.7.  Naprawa rysunków przy problemach z ich zapisaniem, 
otwieraniem czy wyświetlaniem

Może  się  zdarzyć,  że  w  zmienianych  wykresach  pojawią  się  błędy,  które  uniemożliwią  ich

otwarcie  w  innych  programach,  zapisanie  w  progeCAD  czy  spowodują  komplikacje  w  ich

wyświetlaniu.  Problemy  najczęściej  pojawiają  się  w  starszych  rysunkach  lub  wytworzonych

w niekompatybilnym oprogramowaniu CAD.

Błędy te można usunąć korzystając z niniejszych wskazówek:

1. Wybierz w górnym menu Plik → Usługi → Rewizja.
2. W wierszu  poleceń  przy  pytaniu  Czy  chcesz  poprawić  niektóre  błędy?  Tak/Nie/<Nie>:

wybierz A + Enter.
3. Po zapisaniu rysunku błędy miałyby zostać usunięte.

19.8.  Języki programowania

progeCAD 2014 Professional obsługuje następujące języki programowania:

• LISP,

• DRX C++ kompatybilny z AutoCAD® ARX,

• SDS C++ kompatybilny z AutoCAD® ADS, 

• VBA (Microsoft Visual Basic for applications),

• COM automatyzacji,

• .NET

Szczegółową  dokumentację  w  języku  angielskim  znaleźć  można  w  menu

Pomoc →  Rozwój.

Przykłady  niektórych  aplikacji  LISP  w  języku  czeskim  można  znaleźć  na  naszym  forum

dyskusyjnym http://solicad.com/forum/

lub 

na stronie http://www.petrkonecny.eu/autolisp, gdzie znajduje się szereg aplikacji LISP.
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20.  UŻYTECZNE ODNOŚNIKI

Pomoc techniczna http://progecad.pl/g/pomoc-techniczna

Forum dyskusyjne http://progecad.pl/forum/

Filmy instruktażowe http://progecad.pl/c/progecad-wideo

progeCAD na facebooku https://www.facebook.com/pages/progeCAD-

PL/154421461257796

Zgłaszanie błędów w podręczniku info  @progecad.pl
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	2. Potwierdź klawiszem Enter.
	3. Kliknij na obiekty, które chcesz wydłużyć. Linie muszą pozornie krzyżować się z wcześniej wybranymi obiektami.

	7.2.12. Przedłuż
	1. Uruchom funkcję.
	2. Wybierz pożądaną opcję.
	3. Wybierz element kliknięciem - kliknięcie w jedną lub druga połowę obiektu określa kierunek przedłużenia.
	4. Zakończ funkcję lub wybierz dalszy element.

	7.2.13. Przerwij w punkcie
	1. Wybierz obiekt do przerwania.
	2. Wybierz punkt przerwania.

	7.2.14. Przerwij
	1. Wybierz obiekt do przerwania. Tym samym kliknięciem zarówno określisz pierwszy punkt przerwania.
	2. Wybierz drugi punkt przerwania.

	7.2.15. Dołącz
	1. Wybierz obiekty do złączenia (oznaczenie może zawierać kilka obiektów).
	2. Potwierdź klawiszem Enter.

	7.2.16. Fazuj
	1. Do wiersza poleceń wpisz U (Ustawienia) i kliknij Enter.
	2. Otworzy się okno dialogowe, gdzie można nastawić rodzaj i wielkość fazowania. Po doborze ustawień kliknij OK.
	3. Kliknij w dwa przecinające się obiekty do fazowania - zbyteczna część będzie usunięta (o ile w ustawieniach nie wskazano inaczej).

	7.2.17. Zaokrąglaj
	1. Do wiersza poleceń napisz R (pRomień) i kliknij Enter.
	2. Wprowadź pożądany promień zaokrąglenia i kliknij Enter.
	3. Kliknij w dwa przecinające się obiekty do zaokrąglenia - zbyteczna część będzie usunięta (o ile w ustawieniach nie wskazano inaczej).

	7.2.18. Rozbij
	1. Oznacz wybrane elementy do rozbicia.
	2. uruchom funkcję.


	7.3. Modyfikuj – Obiekt
	7.3.1. Obraz
	7.3.1.1. Jakość obrazu
	7.3.1.2. Ramka obrazu

	7.3.2. Edycja kreskowania
	7.3.3. Edycja polilinii (połączenie linii i łuków w polilinię)
	1. Uruchom Edycję polilinii i wybierz jedną linię, która będzie częścią polilinii.
	2. W wierszu poleceń potwierdź zmianę linii w polilinię poprzez T (Tak) i zatwierdzenie klawiszem Enter.
	3. Wybierz następnie P (Połącz) i zatwierdź Enterem.
	4. Oznacz wszystkie linie, które chcesz połączyć w polilinię i potwierdź klawiszem Enter (linie muszą się wzajemnie dotykać punktami końcowymi).
	5. Ukończ działanie funkcji (Enter, Esc lub prawy klawisz myszy).

	7.3.4. Edycja splajnu
	7.3.5. Edycja tekstu wymiaru
	7.3.6. Atrybut
	7.3.6.1. Jeden
	7.3.6.2. Globalny
	7.3.6.3. Menedżer atrybutów bloku

	7.3.7. Wytwórz blok
	7.3.8. Edytuj tekst

	7.4. Zmiana – styl multilinii

	8. WŁAŚCIOŚCI OBIEKTU
	8.1. Kolor, rodzaj i szerokość linii
	8.2. Mierzenie długości i powierzchni

	9. WARSTWY
	9.1. Menedżer właściwości warstwy
	9.2. Tworzenie warstwy
	9.3. Usunięcie warstwy
	9.4. Wklejanie i przesuwanie obiektów do warstw
	9.5. Zapisanie stanu warstw
	9.6. Grupowa zmiana stanu warstw

	10. WYMIARY
	10.1. Style wymiarów
	10.2. Rodzaje wymiarów
	10.2.1. Szybki wymiar
	10.2.2. Liniowy
	10.2.3. Normalny (kierunkowy)
	10.2.4. Współrzędne
	10.2.5. Obrócony
	10.2.6. Szybka linia odniesienia
	10.2.7. Promień
	10.2.8. Łamana
	10.2.9. Średnica
	10.2.10. Kątowy
	10.2.11. Długość łuku
	10.2.12. Linia bazowa
	10.2.13. Wymiar łańcuchowy (kontynuuj)
	10.2.14. Tolerancja
	10.2.15. Znacznik środka
	10.2.16. Kontrola
	10.2.17. Łamanie linii wymiaru

	10.3. Asocjacja wymiarów
	10.4. Przykład wymiarowania średnicy za pomocą wymiaru liniowego

	11. BLOKI
	11.1. iCADLib - manager bloków
	11.2. Własne bloki
	11.2.1. Blok dla konkretnego rysunku
	1. Narysuj pożądany blok.
	2. Uruchom funkcję tworzenia bloków
	3. Wprowadź nazwę bloku.
	4. Przyciskiem Wybierz obiekty wskaż konkretne elementy, które blok będzie zawierać i potwierdź poprzez Enter.
	5. W polu pod opcją Wybierz obiekty wskaż, co program ma wykonać z elementami.
	6. Przyciskiem Wskaż punkt określ punkt referencyjny, w odniesieniu do którego blok będzie się wstawiało.
	7. Potwierdź OK.

	11.2.2. Blok dla wielu rysunków (w samodzielnym pliku)
	1. Narysuj pożądany blok.
	2. Uruchom funkcję tworzenia bloków
	3. Wybierz źródło (blok, cały rysunek, obiekty); przy wyborze całego wykresu pomiń punkty 4 i 5.
	4. Przyciskiem Wybierz obiekty wprowadź obiekty, które blok będzie zawierać. Potwierdź klawiszem Enter. W polu pod opcją Wybierz obiekty wskaż, co program ma wykonać z elementami.
	5. Przyciskiem Wskaż punkt określ punkt referencyjny, w odniesieniu do którego blok będzie się wstawiało.
	6. Wprowadź nazwę bloku.
	7. Określ lokalizację i jednostki.
	8. Potwierdź OK.

	11.2.3. Blok z atrybutami
	1. Narysuj pożądany blok (bez zmiennych opisów).
	2. uruchom dodanie atrybutów
	3. Wprowadź nazwę atrybutu (bez przerw/spacji).
	4. Wprowadź monit (progeCAD wyświetli go w wierszu poleceń jako podpowiedź/nawigację).
	5. Wprowadź tekst domyślny (jako tekst domyślny wybierz najczęściej wykorzystywaną wartość; wartość tę można przy wstawianiu bloku zmienić).
	6. Określ punkt wstawienia.
	7. Wybierz styl i wielkość czcionki.
	8. Kliknij na Definiuj, aby zdefiniować kolejne atrybuty, lub na Definiuj i zakończ, aby zakończyć pracę z atrybutami. Jeśli atrybut nie odpowiada wyobrażeniom, można go przesunąć i zmienić jego właściwości w panelu Własności.
	9. Następnie aby wytworzyć blok przeprowadź jedną z wcześniej opisanych procedur, przy czym do bloku załącz i wytworzone atrybuty poprzez ich oznaczenie.

	11.2.4. Wstawianie bloku
	1. Aby wstawić blok wykorzystaj:
	2. Jeśli rysunek zawiera bloki, możesz wstawić ich kopie poprzez wybór nazwy bloku. W innym przypadku koniecznym jest kliknięcie w przycisk Przeglądaj… i wybór zapisanego bloku.
	3. Wybierz, czy chcesz szybko wstawić blok zaraz po kliknięciu w pole Wstaw (określając następnie ustawienia w przestrzeni roboczej i pasku zada), czy też określić od razu współrzędne, skalę i obrót.
	4. Potwierdź poprzez kliknięcie w pole Wstaw.
	5. Przy wyborze Określ na ekranie wybierasz punkt stawiania, skalę X, skalę Y, kąt nachylenia,
	6. Następnie pojawią się pytania dotyczące wartości atrybutów bloku.

	11.2.5. Edycja bloku
	1. Kliknij na wstawiony blok w rysunku.
	2. Potwierdź pytanie o aktywację edycji lokalnej.
	3. Po potwierdzeniu pojawi się pasek narzędzi Edycja odnośnika. Za jego pomocą można dokonać zmian w bloku.
	4. Przeprowadź pożądane zmiany w bloku a następnie zapisz je klikając w przycisk Zapisz zmiany.
	Blok z atrybutami
	1. Włącz pasek narzędzi Edycja odnośnika (według opisu z rozdziału 5.1 Paski narzędzi).
	2. Kliknij w blok a następnie kliknij na przycisk Edytuj odnośniki (ewentualnie można wprowadzić polecenie _REFEDIT).
	3. Potwierdź pytanie o aktywację edycji lokalnej.
	4. Przeprowadź pożądane zmiany w bloku a następnie zapisz je klikając w przycisk Zapisz zmiany.


	11.3. Bloki dynamiczne

	12. ZEWNĘTRZNE ODNIESIENIA (XREF)
	12.1. Dołączenie
	12.2. Odłączenie
	12.3. Wgranie
	12.4. Uwolnienie
	12.5. Związanie
	12.6. Otwarcie

	13. WYODRĘBNIANIE DANYCH
	1. Uruchom funkcję:
	2. Wybierz pomiędzy aktualnym rysunkiem lub wybranymi obiektami i kliknij Następny.
	3. W lewym oknie zobaczysz bloki, zewnętrzne odniesienia i ich liczbę; oznacz/odznacz pożądane bloki do wyodrębnienia.
	4. Kliknij na blok i w prawym oknie oznacz/odznacz pożądane informacje do wypisania.
	5. Kliknij Następny.
	6. Ukończ wyodrębnianie danych

	14. PRZESTRZEŃ ROBOCZA (MODEL, UKŁAD)
	14.1. Przełączanie pomiędzy modelem a układem
	14.2. Praca z zakładkami układu
	14.3. Rzutnie
	14.3.1. Rzutnie
	14.3.2. Funkcje rzutni
	14.3.3. Własne (poligonalne) rzutnie
	1. Narysuj zamknięty kształt wykorzystując polilinię (po ukończeniu rysowania wybierz komendę Zamknij) - prostokąt, wielokąt, okrąg, elipsę itd.
	2. Uruchom funkcję Własne rzutnie w menu Widok → Rzutnie.
	3. Wybierz zamknięty element.
	4. Potwierdź klawiszem Enter.

	14.3.4. Skala rzutni
	1. Oznaczyć zmieniany widok.
	2. W menu Dostosuj wybrać skalę.
	3. Jeśli w menu nie znajduje się pożądana skala, można ją wpisać bezpośrednio (np. 1:3) i kliknąć Enter.

	14.3.5. Zmiana pozycji przestrzeni modelu w rzutni
	14.3.6. Zamknięcie rzutni
	1. Kliknij w rzutnię prawym klawiszem myszy.
	2. W panelu Własności w kategorii Różne przełącz opcję Zamknięte wyświetlanie na Tak.

	14.3.7. Usunięcie ramki rzutni

	14.4. Wymiarowanie

	15. DRUK
	15.1. Druk z modelu
	1. Uruchom funkcję wydruk
	2. Możesz wybrać Ustawienia strony → nastawi wszystkie parametry druku wg zapisanych wcześniej ustawień.
	3. Wybierz Drukarkę.
	4. Ustaw Rozmiar papieru.
	5. Ustaw Skalę wydruku i Jednostki.
	6. Ustaw Orientację rysunku.
	7. Ustaw obszar wydruku (Wyświetl, Zakresy, Granice, Okno). Przy opcji Okno musisz jeszcze wybrać obszar wydruku.
	8. Wybierz opcję z pola Tabelka stylu wydruku.
	9. Wybierz opcję z pola Opcje rzutni cieniowanej.
	10. Ustaw Opcje wydruku – styl i grubość linii, druk w tle, pieczątka rysunku itd.
	11. Ustaw pożądaną opcję przy Centruj wydruk.
	12. Kliknij w Podgląd... i w przypadku, gdy wynik odpowiada Twoim wyobrażeniom, kliknij Drukuj.

	15.2. Druk z układu
	1. Uruchom funkcję wydruk
	2. Możesz wybrać Ustawienia strony → nastawi wszystkie parametry druku wg zapisanych wcześniej ustawień.
	3. Wybierz Drukarkę.
	4. Ustaw Rozmiar papieru.
	5. Ustaw skalę wydruku 1:1 i jednostki. Skala 1:1 jest ważna, jeśli pożądaną skalę ustawiasz w rzutniach w przestrzeni wykresu.
	6. Ustaw Orientację rysunku.
	7. Ustaw obszar wydruku (Wyświetl, Zakresy, Granice, Okno). Przy opcji Okno musisz jeszcze wybrać obszar wydruku.
	8. Wybierz opcję z pola Tabelka stylu wydruku.
	9. Wybierz opcję z pola Opcje rzutni cieniowanej.
	10. Ustaw Opcje wydruku – styl i grubość linii, druk w tle, pieczątka rysunku itd.
	11. Ustaw pożądaną opcję przy Centruj wydruk.
	12. Kliknij w Podgląd... i w przypadku, gdy wynik odpowiada Twoim wyobrażeniom, kliknij Drukuj.

	15.3. Druk rysunków do PDF i JPG

	16. OBRAZ
	16.1. Manager obrazów
	16.2. Wstawianie obrazu
	1. Uruchom dołączanie obrazu
	2. Znajdź i otwórz pożądany obraz.

	16.3. Odłączenie obrazu
	16.4. Jakość obrazu
	16.5. Ramka obrazu
	16.6. Dopasuj obraz
	16.7. Kolejność rysowania
	16.8. Przycinanie obrazu
	16.9. Transparentność

	17. DODATKI
	17.1. Wektoryzacja WinTopo
	17.2. Konwersja PDF do DWG
	17.3. Import widoku z Google Earth
	17.4. Eksport PDF 3D

	18. NARZĘDZIA EKSPRES
	18.1. Zaawansowane funkcje myszki
	1. Uruchom funkcję
	2. Wprowadź wartość 0 lub 1 (wyłączone lub włączone).
	3. Potwierdź klawiszem Enter.


	19. OPCJE ZAAWANSOWANE
	19.1. Obrót LUW (lokalnego układu współrzędnych) i widoku
	19.1.1. Obrót LUW według obiektu
	19.1.2. Widok

	19.2. Ustawienia pasków narzędzi, dodanie ikon i skrótów klawiszowych
	19.2.1. Dodanie ikon do pasków narzędzi
	1. Otwórz okno dialogowe w menu Narzędzia → Dostosuj → Menu... → zakładka Paski narzędzi.
	2. W lewej kolumnie kliknij na odpowiednią kategorię.
	3. W prawo od niej pojawią się dostępne ikony. Uchwyć pożądaną ikonę i przeciągnij ją do jakiegokolwiek paska narzędzi między używane już ikony lub do wolnej przestrzeni, aby wytworzyć nowy panel.

	19.2.2. Usuwanie ikon z pasków narzędzi
	1. Otwórz Narzędzia → Dostosuj → Menu... → zakładka Paski narzędzi.
	2. Aby usunąć dodaną ikonę z paska narzędzi wystarczy ją uchwycić i przesunąć poza panel (okno dialogowe musi być w tym czasie otwarte).

	19.2.3. Zmiana funkcji ikon w paskach narzędzi
	19.2.4. Własne skróty klawiszowe (aliasy)
	19.2.5. Własne skróty klawiszowe (klawiatura)

	19.3. Kolor tarczy kursora
	19.4. Wielkość tarczy kursora
	1. Górne menu Narzędzia → Opcje... → Uchwyty.
	2. Zmień wielkość znacznika uchwytu.
	1. wprowadzić polecenie _pickbox,
	2. potwierdzić klawiszem Enter,
	3. wprowadzić nową wartość, np.10 (domyślnie to 3),
	4. potwierdzić ponownie klawiszem Enter.
	Ustawienie to można także zmienić poprzez menu Narzędzia → Ustawienia rysowania → zakładka Wklejanie współrzędnych → zmiana na Wybór obiektu → Ramka oznaczania obiektów.

	19.5. Znaki specjalne
	19.6. Własne rodzaje linii
	19.6.1. Proste
	1. Uruchom progeCAD Explorer
	2. W prawym oknie Explorera poprzez prawy klawisz lub w menu Edycja wybierz Nowy → Rodzaj linii.
	3. Pojawi się okno do zdefiniowania własnego rodzaju linii. Wprowadź nazwę rodzaju linii, opis rodzaju linii i definicję rodzaju linii. Aby zdefiniować rodzaj linii należy dotrzymywać niniejszych reguł:
	4. Kliknij "OK" i wybierz nowo utworzony typ linii. Następnie wyświetli się on w użytych rodzajach linii:
	Tworzenie własnego rodzaju linii za pomocą wiersza poleceń:
	1. Do wiersza poleceń wprowadź _-linetype, wybierz T (wyTwórz) i wpisz nazwę nowego rodzaju linii.
	2. Wyświetli się następnie okno zapisu rodzaju linii do nowego pliku lub przyłączenia rodzaju do dotychczasowego pliku. Do dodania nowego rodzaju wybierz np. plik ICAD.lin lub zdefiniuj nowy plik z końcówką .lin.
	3. W wierszu poleceń wstaw opis nowego rodzaju linii według własnego uznania i kliknij Enter.
	4. Wprowadź definicję nowego rodzaju linii wg zasad przedstawionych wyżej na przykładzie definiowania przez progeCAD Explorer. Początkowa litera "A", która jest nastawiona automatycznie oznacza, że rodzaj linii będzie zawsze dostosowany między dwoma wierzchołkami tak, aby linia kończyła się przecinkiem. Potwierdź klawiszem Enter i wypróbuj rysowanie z nowym rodzajem linii.

	19.6.2. Złożone
	1. W edytorze tekstu (np. notatnik) otwórz plik icadiso.lin, który znajdziesz w folderze ustawień użytkownika. Folder ten otworzysz przy pomocy Centrum progeCAD - więcej rozdział 3.4 Centrum progeCAD.
	2. Do pliku masz możliwość dodać definicję nowego rodzaju linii. Definicja zawiera dwa rzędy utworzone wg wzoru wcześniejszych linii a ich składnia jest następująca:
	Rząd 1:
	3. Wklejanie tekstu do linii
	4. Wklejenie kształtu (shapes) do linii
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